Thermo-Calc Installation Guides

Thermo-Calc Version 2024a

Including the TC-Python and TC-Toolbox for MATLAB® Installation Guides

Thermo-Calc
Software



Copyright 2024 Thermo-Calc Software AB. All rights reserved.

Information in this document is subject to change without notice. The software or database
described in this document is furnished under a license agreement or nondisclosure
agreement. The software or database may be used or copied only in accordance with the terms
of those agreements. You can read more on our website.

Thermo-Calc Software AB
Rasundavagen 18, SE-169 67 Solna, Sweden
+46 8 545 959 30

https://thermocalc.com/


https://thermocalc.com/terms-and-conditions-for-the-purchase/

Installing Thermo-Calc

Installing Thermo-Calc

In this section:

Key 1o USiNg this GUILE ... e 4
Installation TermMiNOlOgY .. ... oo 6
About the Thermo-Calc Components Being Installed ... ... 8
System Requirements 10
Platforms Tested and SDK Availability ... 11

Installing Thermo-Calc | 3 of 152



Installing Thermo-Calc

Key to Using this Guide

;Q»_ This guide is available in PDF format: (1) On the website or (2) when in
¥ Thermo-Calc go to Help - Manuals Folder - Installation.

This installation guide is for all Thermo-Calc installations running on Windows, macOS, or Linux
operating systems. It is also applicable to previously installed versions of Thermo-Calc (the new
version is installed next to the old version).

This guide includes information about:

e The types of licenses and installations available.

¢ Installing the Thermo-Calc software and its components on standalone computers,
servers, and client computers.

¢ |Installing the license management software for network installations.
e Retrieving and installing license files.

e Details about the specific instructions needed to install two of the SDKs, TC-Python and
TC-Toolbox for MATLAB®.

¢ Troubleshooting to solve common installation problems.

¢ Updating and uninstalling the software.

Icons in this Guide

Name Description

. Provides important information and indicates that more detail is located in
Information ) .
the linked or named topic.
Note [% The information can be of use to you. It is recommended that you read the
text or follow the link.
Operating system The operating system is indicated when the information is specific to a Windows, macOS, or
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Description

L License file

A

Linux operating system.

The Thermo-Calc license file, which contains the license keys and is installed on either a
standalone computer or a network server.

The Thermo-Calc software and its components (including databases and SDKs) to be installed.

Typographical Conventions

Convention

Definition

Forward arrow =

Boldface font

Italic font

code and code bold

The forward arrow symbol = instructs you to select a series of menu items in a specific
order. For example, File - Save Project is equivalent to: From the File menu, select
Save Project.

A boldface font indicates that the given word(s) are shown that way in on a toolbar
button or as a menu selection. For example, if you are told to select a menu item in a
particular order, such as File - Save Project, or to click Save.

An italic font indicates the introduction of important terminology. Expect to find an
explanation in the same paragraph or elsewhere in the guide.

A code font indicates you are to make a keyboard entry. It also shows a programming
code or code examples. The code bold font highlights the entry.
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Installation Terminology

Definition

client

consolidated network

distributed network

host ID

license file

license key

license management software
(see Sentinel RMS License
Software)

license server

Network License (NWL)

Sentinel RMS License Software

A computer without a license file of its own but connected through the network to a
computer with the license information. The client receives a license token from the
computer where the license management software is installed.

A type of network installation where the Thermo-Calc software and a Thermo-Calc
licensing software are installed on a single server computer. This allows all computers
in the network to access both the software and a license on the server via a client
installation.

A type of network installation where the Thermo-Calc software is installed on one
server computer in a network and the Thermo-Calc licensing software is installed on a
different computer. After a thin client installation, all computers in the network can
access both the software and the network license key via the server.

The MAC address on the computer that a license is locked to.

The file (called Iservrc) that contains all the purchased license keys. It is issued by
Thermo-Calc Software, usually by email.

The information contained in the license file that represents the products purchased
and which is then authorised for installation.

The Thermo-Calc license management software. When working in Windows it is called
License Manager (full name is Sentinel RMS License Manager by SafeNet) and on Linux
it is called License Server (full name is Sentinel License Sever by Safenet).

The use of the term license server (lower case letters) is reserved for use for scripts
and option files (for example, in an "Unattended Network Client Installations" on

page 64). For the purposes of the step-by-step instructions it is not used to refer to the
type of network installation that runs the license management program. See Sentinel
RMS Software below.

The license type used with the licensing software. The NWL can only be used on one
specific computer that hosts the licensing software. This restricts license usage to a
certain subnet or subnets.

The software may be used on the number of sites you have paid for and by the
number of persons you have paid for on any number of network connected computers

The Thermo-Calc license management software that supplies the client computers in
your network with license tokens when it runs the Thermo-Calc software. This is
available for both Windows (called the License Manager) and Linux (called the License
Server, but not to be confused with license server in lower case letters reserved for
scripts).
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Definition

Single-User-Node Locked-
License (SUNLL)

standalone computer

TC-Toolbox

thin client

XQuartz

A unique license file for one designated computer at one designated site. It cannot be
copied or moved outside the site. If the software is installed on a portable computer, it
can be temporarily used off-site. The license can be used without network access (to
the License Server).

A computer which uses a SUNLL license type.

The short name for the TC-Toolbox for MATLAB® SDK.

An installation where the software is installed on a file server but is run from a client
computer. The licensing software may be installed on the file server (consolidated
network installation) or on a different computer (distributed network installation).

An open-source X Windows System, which is required to run Thermo-Calc on a Mac.
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About the Thermo-Calc Components Being Installed

What is Installed with a Full Standalone or Full Network Client
Option?

At the start of the installation process, the following components are installed when you
choose either the Full Standalone or Full Network Client options. If you want to exclude a
component (perhaps one of the SDKs), then you would use the Custom option.

Select Installation Mode

Full 5tandalone

[n=tall all features
O

Choose a license file

Full Metwork Client

[nstall all features
O

A full installation means that all listed feature components are installed but the availability of
the individual components is based on the license you have. This is also applicable to the
databases and software development kits (SDKs).

Thermo-Calc

The Thermo-Calc software includes several add-on features and capabilities that are packaged
with the software and included with a full standalone or network client installation. For
example, there are the specialized add-on products Diffusion Module (DICTRA), Precipitation
Module (TC-PRISMA), and Process Metallurgy Module as well as the Steel Model Library. For
most of these specialized features, demonstration (demo) versions and/or examples are
available for all users but advanced features are only available with a license.

Databases

All the latest databases are installed. As with the software features, availability of a specific
database in the software itself is based on license. However, several demonstration
(demo) databases are included and available to all users.
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Software Development Kits (SDKs)

When the Full Standalone or Full Network Client option is chosen, it also installs the software
development kits (SDKs) (e.g. TC-Python, TQ-Interface, TC-Toolbox for MATLAB®, etc.).

TC-Python

The TC-Python program is installed when the Full Standalone or Full Network Client option is
chosen, but there are additional steps required to complete the installation as described in the
TC-Python Installation Guide.

TC-Toolbox for MATLAB®

If a MATLAB® installation on your computer is found during this installation process, the
TC-Toolbox for MATLAB® (available only for Windows) is automatically installed, otherwise you
may need to do a manual installation. For details, see the TC-Toolbox for MATLAB Installation
Guide®.

What Does the Custom Option Allow Me to Do During an
Installation?

During the installation process, there is some flexibility to choose what to include or exclude
with the installation by choosing the Custom option. This is primarily to the level of being able
to choose the SDKs or to exclude all databases or Thermo-Calc itself. That is, you cannot choose
specific Thermo-Calc features or databases as these are controlled by the license and not the
installation procedure.
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System Requirements

O "About the Thermo-Calc Components Being Installed" on page 8

I General

A full list of system requirements and program availability is found on the Thermo-Calc website.
You can also see the roadmap for platform support to use for planning purposes.

| Network Client Installations: Sentinel RMS License Software

. Network client installations using the Sentinel RMS license management software
require the use of the most recent version, 9.7.

For details of the system requirements to install Sentinel RMS, see "Windows: About Installing
the License Manager" on page 47 and "Linux: About Installing the License Server" on page 52.

[% For macQS, the Sentinel RMS License software is installed on a Windows or Linux
computer server where the Thermo-Calc license file must also be located.
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Platforms Tested and SDK Availability

A full list of system requirements and program availability is found on the Thermo-Calc website.
You can also see the roadmap for platform support to use for planning purposes.

I Platforms Tested

Thermo-Calc and its components are tested on these platforms for Thermo-Calc 2024a:

m

e Ubuntu 22.04 (Jammy Jellyfish)
e Sonoma 14.x
e Windows 10 64-bit e Ubuntu 20.04 (Focal Fossa)
e Ventura 13.x
e  Windows 11 e Cent0S7.9
e Monterey 12.x
e OpenSUSE 15.4 and 15.5 (Leap)

1 Thermo-Calc Software cannot guarantee full functionality if the software is installed on other Linux distributions.

2 |f you are installing on CentOS 7, it is recommended you install gtk2 before you run the installation script.

I SDK Availability by Platform

The software development kits (SDKs) are available as follows for the indicated platforms:

SDK Windows macOS Linux
TC-Python X X X
TQ-Interface X not available X
TC-Toolbox for MATLAB® X not available not available
TC-API X not available X
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License and Installation Types

In this section:

License and Installation Ty pes ... 13
About License Keys and Files ... 14
Standalone Installations (SUNLL) ... 15
Multi-User Network Installations (NWL) ... 16
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License and Installation Types

License and Installation Types

Installation procedures are based on the license type, the installation type, and the operating
system.

(?)  Visit our website for more information about Licensing Options.

[% For macQS, the Sentinel RMS License software is installed on a Windows or Linux
computer server where the Thermo-Calc license file must also be located.

License type Installation Type Windows macOS Linux

SUNLL Standalone Yes Yes Yes
Consolidated network Yes No Yes

NWL Distributed network Yes No Yes
License installations on a server network Yes Yes Yes

I Sentinel RMS License Management Software: Use Current Version

The most recent version (9.7) of the Sentinel RMS License Manager (Windows) and License
Server (Linux) is included with the network license Thermo-Calc software download.

However, due to security issues reported by the vendor, it is important that previous network
license installations of the Sentinel RMS are upgraded to this version number.

For more information for your operating system, see "Windows: About Installing the License
Manager" on page 47 and "Linux: About Installing the License Server" on page 52
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License and Installation Types

About License Keys and Files

To run Thermo-Calc and its components you need a valid license key for each product. The
license keys are included in the license file emailed to you by Thermo-Calc Software.

You can copy the license file to the applicable computer(s) before or after installing the
software—the license file itself is not required during the installation process. However, it is
required to make calculations in Thermo-Calc.

If:) "Request a License File from Thermo-Calc Software" on page 67
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Standalone Installations (SUNLL)

The standalone installation is used with the Single-User Node-Locked License (SUNLL). The

Thermo-Calc software £ and a Thermo-Calc license file .. are installed on a standalone
computer. You can do a full (all operating systems) or a custom installation (Windows and Linux
only).

A+ =

@ To get started, go to "First Steps of Installation" on page 20 and then "Standalone
Installations" on page 35.
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Multi-User Network Installations (NWL)

There are different types of multi-user network installations: consolidated, distributed, and
where the licensing software is installed on a computer network. There is also a subtype of
installation called thin client, which is a step done with the consolidated and distributed
network installations.

Thin client installations: A thin client installation is where the Thermo-Calc
software is installed on a computer server but is run from a client computer. The
licensing software can be installed on the computer server (a consolidated

[% network) or on a different computer (a distributed network). This type of
installation is available for Windows and Linux operating systems. The client
computer must have the Thermo-Calc software installed. This type of installation
mainly sets environmental variables and paths on the client computer.

\.

I Consolidated Network Installations

The consolidated network installation is used with a Network License (NWL) and it is available
for Windows and Linux operating systems.

D ) -

The Thermo-Calc software £ and the license management program are installed on the same

server where the license file L is also copied. A thin client installation allows all computers
(the clients) in the server network to access both the software and the licensing on the same
computer server.
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@ To get started, go to "First Steps of Installation" on page 20 and then "Network
Client Installations" on page 44.

| Distributed Network Installations

The distributed network installation is used with a Network License (NWL) and is available for
Windows and Linux operating systems.

-
-

The Thermo-Calc software £\ is installed on one computer server in a network and the

licensing software is installed on a different computer server where the license file L isalso
copied. A thin client installation allows all computers (the clients) in the server network to
access both the software and the licensing on the two computer servers.

@ To get started, go to "First Steps of Installation" on page 20 and then "Network
Client Installations" on page 44.

I License Installations on a Server Network

When a license file is installed on a server network, it is used with a Network License (NWL). It
is available for all platforms. However, for macOS the server containing the licensing software
must be set up on Windows or Linux.
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The licensing software is installed on a computer server where the license file L isalso
copied. The Thermo-Calc software £ is installed on every computer in the network that needs

it.

@ To get started, go to "First Steps of Installation" on page 20 and then "Network
Client Installations" on page 44.
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Preparing for Installation

In this section:

First Steps of Installation ... 20
Installation Default Directories and the License File ... 21
Installation Default Directory: WindoOWs ... 22
Installation Default Directory: MacOS ... 23
Installation Default Directory: LINUX ... 24
Installation Default Directory: Databases, Database Checker, and TDB Editor ...................... 25
Installation Default Directory: Materials ... 27
Installation Default Directory: Process Metallurgy Materials ... 29
Installation Default Directory: Custom Property Models ... 30
Subnet Information for Network Licenses ... . 31
macOS Installation Notes ... . 32
Linux Installation NoOtes ... 34
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First Steps of Installation

This section reviews some of the things you need to do before installing the Thermo-Calc
software.

e Learn about the different default directories where the software and license files are
installed.
¢ For network installations, collect subnet information.

e Make sure the person installing the software has administrator rights for Windows and
macOS.

e For macOS§, install XQuartz and make sure the security preferences are set correctly.
e For a Linux Cent OS 7 installation, also install gtk2 before you run the installation script.

yum install gtk2

Should I get my license file before or after software installation? The
Thermo-Calc license file itself is not required during the installation process.

[% However, it is required to make calculations in Thermo-Calc. The license file has
details about your computer(s) that in some cases cannot be determined
accurately until after installation (especially for a network installation). For most
users it is recommended you request the file before you start installing.
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Installation Default Directories and the License File

The default directories where the software and its components are installed, including where
the license file is stored, vary by platform and user type.

If you want to select specific components to install or if you want to install the software in a
non-default installation directory, then do a custom installation (Windows and Linux only). In
the table, <user> stands for the user name and <version> for the version of Thermo-Calc, for
example 2024a.

I License File Installation Location for All Operating Systems

The Thermo-Calc license file is installed outside of the installation program folder. If you have
more than one version of Thermo-Calc installed then there are additional folders by version
number with only one license file.

For macOS the license file is put in /Users/Shared/Thermo-Calc. The example below is for a
Standalone Windows installation.

05(C) » Program Files * Thermo-Calc

[] Mame
2022a
2022b
2023a

| | lservrc

See the following for more information:

"Installation Default Directory: Windows" on the next page
¢ "Installation Default Directory: macOS" on page 23
¢ '"Installation Default Directory: Linux" on page 24

¢ '"Installation Default Directory: Databases, Database Checker, and TDB Editor" on
page 25

¢ '"Installation Default Directory: Materials" on page 27

¢ "Installation Default Directory: Process Metallurgy Materials" on page 29
¢ "Installation Default Directory: Custom Property Models" on page 30

¢ "Installation Default Directory: TC-Python" on page 94

¢ "Installation Default Directory: TC-Toolbox and the Examples" on page 104
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Installation Default Directory: Windows

Administrative rights are required to install and uninstall Thermo-Calc.

Windows User
Type

Administrator

Server network

Default Directory

The Thermo-Calc program is installed here:

Program Files\Thermo-Calc\<version>

The default folders where documents, materials files, examples, and other folders that sometimes
require additional licenses are installed under Public Documents for ALL USERS.

For a local user these files are copied to the user’s Documents folder where this local copy is
associated to the user login. The Public Documents folder always contains the original set of
contents as per the installation.

C:\Users\Public\Public Documents\Thermo-Calc\<version>

After installing Thermo-Calc, and when you first open the program, the set of folders is copied from
the source Public Documents location into a user Documents folder:

C:\Users\<user>\Documents\Thermo-Calc\<version>

It is recommended that you work with the files that are copied to the user folder.

In some cases when an interim software update is installed there is also a backup
folder created in this folder. For details, see "Updating the Software for Interim
Releases" on page 145.

License software installations on a server network (the License Manager software)

C:\Program Files (x86)\Common Files\SafeNet Sentinel\Sentinel RMS License
Manager\WinNT\
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Preparing for Installation

Installation Default Directory: macOS

macOS User Type Default Directory

The Thermo-Calc program is installed in the Applications folder:

Thermo-Calc-<version>.app and uninstall-Thermo-Calc-<version>.app

The documents, materials, examples, and other folders that sometimes require additional
licenses are installed here:

Administrator (USEI’ /Users/Shared/Thermo-Calc/<version>
name and password
required) In some cases when an interim software update is installed there is also a

backup folder created in this folder. For details, see "Updating the Software
for Interim Releases" on page 145.

To go to this folder, in Finder, from the Go main menu select Go to folder. Enter the above
file path and click Go.

Installation Default Directory: macOS | 23 of 152



Preparing for Installation

Installation Default Directory: Linux

Linux User Type Default Directory

The Thermo-Calc program including the documents, materials, examples, and
Non root user other folders that sometimes require additional licenses are installed here:

/home/<user>/Thermo-Calc/<version>

The Thermo-Calc program including the documents, materials, examples, and
other folders that sometimes require additional licenses are installed here:
/opt/Thermo-Calc/<version>

Root user
In some cases when an interim software update is installed there

is also a backup folder created in this folder. For details, see
"Updating the Software for Interim Releases" on page 145.

If you are doing a network installation then these files are available as a tar-file

License software installations on a from the Thermo-Calc website. Contact Support for more information.

server network (the License Server

software) In the downloaded tar-file, there is a restart_Iserv script file, which can be used as

a template for creating a script that starts up the License Server.
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Installation Default Directory: Databases, Database
Checker, and TDB Editor

The standard Thermo-Calc databases and the database initialization file tc_initd.tdb are
located in a subfolder to the Thermo-Calc installation. For example, in a Windows Standalone
installation, you can find these in a folder called data where the file path is C:\Program
Files\Thermo-Calc\<version>\data.

» ThisPC » 0OS(C:) » Program Files » Thermo-Calc » <Memion> data

O Mame ) Type
1.4 te_initd.tdb Thermo-Calc files
| | STANDARD_DB_CLASSES.BIM BIM File
|| databases.ser SER File
TCZR1 File folder
TCTI4 File folder

I Database Checker

The Thermo-Calc software package includes a program to check that the syntax of unencrypted
database files is correct. The program applies the syntax rules set out in the Database Manager
User Guide and reports errors and issues warnings. This program is intended for advanced users
who develop and manage databases.

' )

Thermo-Calc accepts some deviations from these syntax rules. Although warnings
can be ignored, errors must be corrected. Reported errors must be corrected in

E] the TDB file before the database can be loaded by the application. Sometimes the
warnings can also reveal the need for additional corrections as shown in the
example below.

For example, a warning is generated if a phase name is detected that is also an abbreviation of
another phase name in the database. Although allowed, it is not recommended as this can (in
some cases) lead to unexpected results because abbreviations are also used when entering
commands in the Console and included in macro files. The following shows why in this case an
abbreviation is not recommended.

Imagine that a macro file uses the abbreviation aBc to refer to a phase in a database that is
named 2ABCDE. As long as there is no other phase in the database with the same exact name or
initial abbreviation, it works. But if a new phase is added to the database and is actually named
aBC then the macro can in error refer to the wrong phase. The macro still runs but now refers
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to the phase aBc instead of ABCDE because aABc is an exact match, which takes precedence over
abbreviations. The Database Checker displays a warning because this situation can only occur
when one phase name is an abbreviation of another.

With respect to using this tool, the executable patabasechecker file is found in the
Thermo-Calc home directory.

The program can also be launched by selecting Tools < “xDatabase Checker from the main
menu in Thermo-Calc.

| TDB Editor

The TDB Editor is an editing tool for those who develop their own custom databases for use
with Thermo-Calc or other applications. The tool speeds up the database editing process by
providing immediate feedback through syntax coloring, syntax checking, and by allowing
formatting and easy navigation to items of interest in the TDB file.

During installation, the tdb-1anguage-support.vsix file is installed in the Thermo-Calc home
directory.

E] In order to access the most-up-to-date version of the VSCode plugin, it must be
updated every time a new version of Thermo-Calc is installed.

For information about installing the TDB Editor, which is separate from the main

installation and can be done later, see the Database Manager's User Guide

- contained in the Thermo-Calc Documentation Set or press F1 in Thermo-Calc and
search the help.

-

#_
Ly

Installation Default Directory: Databases, Database Checker, and TDB Editor | 26 of 152



Preparing for Installation

Installation Default Directory: Materials

When you are working with the System Definer or Material to Material Calculator you can open
the default Materials folder included with your installation.

At the bottom of the window under Material, click Load material to navigate to a material file.

There is a separate folder for materials saved using the Process Metallurgy
[% Calculator. See "Installation Default Directory: Process Metallurgy Materials" on
page 29.

[% For the Additive Manufacturing (AM) Module, the Material Properties library is
managed by the software.

-\ »

Load matenal
Look In: Materials ~ M & o

Save material as...

Aluminum Alloys
Cast Iron

My Materials
Nickel Alloys
Solder Alloys
Steel

Titaniumn Alloys

File Mame:

Files of Type: | Material file [*xml] R4

The default directory where these material files are stored is based on operating system:

Operating System Materials Installation Directory

Windows C:\Users\<user>\Documents\Thermo-Calc\2024a\Materials

On Linux all user files are installed where the program is installed. If installed as root the default
Linux is:

/opt/Thermo-Calc/2024a/Materials
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Operating System Materials Installation Directory

macOS /Users/Shared/Thermo-Calc/2024a/Materials
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Installation Default Directory: Process Metallurgy
Materials

With the Process Metallurgy Calculator you can save materials to work with again. This is the
default folder where these are stored based on your operating system:

Operating System Process Metallurgy Materials Installation Directory

Windows C:\Users\<user>\Documents\Thermo-Calc\2024a\ProcessMetallurgyMaterials

On Linux all user files are installed where the program is installed. If installed as root the
Linux default is:

/opt/Thermo-Calc/2024a/ProcessMetallurgyMaterials

macOS /Users/Shared/Thermo-Calc/2024a/ProcessMetallurgyMaterials
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Installation Default Directory: Custom Property Models

All Property Models (whether these are predefined or custom models) must be
located in a subdirectory of the Property Model directory. You can go to the

Options window then on the General tab the Model directory field displays the
default directory.

To open the Options window:
e Windows: Select Tools = == Options.

e Mac: Select Thermo-Calc <version> -> Preferences or Settings or press <db> on the
keyboard.

Predefined models included with the Property Model Calculator are installed in the locations
below based on your operating system. If you create your own models using TC-Python, this is
the default directory where these are saved.

Operating System Property Model Installation Directory

Windows C:\Program Files/Thermo-Calc/2024a\PropertyModels

On Linux all user files are installed where the program is installed. If installed as root the
default is:

Linux /opt/Thermo-Calc/2024a/PropertyModels

or:

/home/<username>/Thermo-Calc/2024a/PropertyModels

macOS /Applications/Thermo-Calc-2024a.app/Contents/Resources/PropertyModels

Installation Default Directory: Custom Property Models | 30 of 152



Preparing for Installation

Subnet Information for Network Licenses

This is related to "Full Network Client Installations" on page 45.

For network licenses, the subnet information is also required. Ask your network administrator
for the network address for the subnet. Additional requirements are included elsewhere for
network installations.

e Subnets should be in the format aaa.bbb.ccc*** (for example: 192.168.29.0/24 or
192.168.29.*

¢ When installing on Sentinel RMS License Server version 9.7, a maximum of seven (7)
subnets are permitted.

An alternative way to get this information is to run the command:

e Windows: ipconfig /all

e macOS/Linux: ip a
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macOS Installation Notes

How to Restart After an Installation

In some types of installations (e.g. a network installation), you may have to restart your Mac to
use Thermo-Calc for the first time.

How to Install XQuartz

The XQuartz open-source X Windows system is required to run Thermo-Calc on macOS but it is
not required to install Thermo-Calc. Before installing Thermo-Calc, you may also need to ensure
that the computer security permissions are set.

1.

In a web browser go to https://www.macupdate.com or to download it directly from
XQuartz, https://www.xquartz.org/.

In the Search Mac Apps field, enter XQuartz.

Click the XQuartz search result. For example, based on the recent version, the name is
XQuartz-2.7.11.dmg.

Click Download.
Double-click the XQuartz.pkg file. Follow the instructions.

Click OK when the message about logging out displays and click Close when the installation
is successful.

How to Enable the Security Settings

From the Apple main menu, select System Preferences.
Click Security and Privacy.

Click General. At the bottom of the Security & Privacy window, click the lock icon to make
changes. Enter the administrator password as required.

If you have already tried to launch the Thermo-Calc installer, you can click Open Anyway
to proceed. Otherwise, under Allow apps downloaded from: click Anywhere and then
Allow from Anywhere.

Continue with the applicable installation type (standalone or network).
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[ [% Remember to reset your security after installing Thermo-Calc.
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Linux Installation Notes

The following are details you need to know regarding your Linux installation as well as how to
open Thermo-Calc.

I openSUSE Administration (sudo) Users

Note the following if you are a sudo user (administrator) in openSUSE installing Thermo-Calc
using this command:

sudo ./Thermo-Calc-linux-<full-version-number>.run

When this command is used, you will do a text-based installation instead of having a graphical
interface to guide you. The information is the same, just without the user interface.

a )

For example, the <full-version-number> is not just 202443, it is what is found in the
:@: Help - About window in Thermo-Calc and it changes every release. You can find
the current full version number listed on our website.

I Opening Thermo-Calc in Linux

To open Thermo-Calc double-click the Thermo-Calc-2024a application or from the Thermo-Calc
installation directory enter $ ./Thermo-Calc-2024a.sh in the terminal.
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Standalone Installations

You can either do a full or a custom standalone installation. The license type is called a Single-
User Node-Locked License (SUNLL).

In this section:

Full Standalone Installations ... 36
Custom Standalone Installations ... 40
Add New Components to an Existing Installation ... . 43
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Full Standalone Installations

The following describes a full standalone installation. These steps assume you have completed
the section "First Steps of Installation" on page 20.

I Step 1. Request your License File from Thermo-Calc Software

Updates to Thermo-Calc: Customers who subscribe to the annual maintenance
plan can skip this step if you have received your license file in an email from

[% Thermo-Calc Software AB. Save the license file to your computer to use during
software installation. The license file name must be the same as the existing file
name to ensure there are no errors during the update.

Follow the instructions for your operating system in the section "Request a License File from
Thermo-Calc Software" on page 67.

I Step 2. Download your Thermo-Calc Installation Software

e Web downloads: For web links sent in an email from Thermo-Calc Software, go to the
URL and log in with the information provided to download the software.

e DVD installations: Insert the DVD and follow the instructions.

Step 3. Run the Applicable Installation File for your Operating
System

1. Navigate to the folder for your operating system and click the link to download the
software package, then go to the folder where you downloaded it.

[ Administrative rights are required for Windows and macOS installations.

Windows

Double-click the .exe file to launch the Setup program.

macOS
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Double-click the downloaded file then follow the instructions.

For macOS and when you first run the installer, you may see a message that

Thermo-Calc-osx-<version> can't be opened because Apple cannot check it for
‘:@:‘ malicious software. If this happens, select Show in Finder. Then, in the opened
Finder window right-click the downloaded file Thermo-Calc-osx-<version>and

select Open.

Linux
To start the Setup Wizard in a Terminal window, enter these commands in the directory where
the installation file is saved:

> chmod +x linux-installation-x64-2024a.run

> ./linux-installation-x64-2024a.run

[% If you are an openSUSE root user, see "Linux Installation Notes" on page 34 for
some information about your installation.

2. On the Setup window click Next.

3. Onthe License Agreement window click the button to accept the license agreement
then click Next.

I Step 4. Select the Installation Type and Upload the License File

{_F_':) "About the Thermo-Calc Components Being Installed" on page 8

1. In the Select Installation Mode window click Full Standalone: Install all features.

If you want to exclude a component (e.g. an SDK), then use the Custom
:@_ option. See "Custom Standalone Installations" on page 40. For TC-Toolbox
"7 for MATLAB®, also see "Installing TC-Toolbox with the Custom Option" on

page 107.
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TC-Python is installed when the Full Standalone or Full Network Client
option is chosen, but there are additional steps required as described
separately for this SDK.

2. For a Full Standalone installation, in the Choose a license file field either enter the file
path or click the file button ' to navigate to where you saved the license file emailed
to you from Thermo-Calc Software. The license file is called Iservrc.

A Setup

Select Installation Mode

Full Standalone

Install all features

®
Choose a license file C:\Userstamanda'Downloads\LSERVRJ

[% To prevent errors, leave this field blank if you did not get a license file yet.

TC-Python is installed for all users even without a license. The Install TC-Python window
is a reminder that additional installation procedures are required after Thermo-Calc is
installed.

I Step 5. Install the Software and Start Using Thermo-Calc
1. Inthe Ready to Install window click Next.

-

.1__':) See the separate instructions for TC-Toolbox for MATLAB®.

2. Click Finish and start using Thermo-Calc. For Linux users, log out and log back in to
finish the installation.
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macOS installations and if you have previous Thermo-Calc installations:
When you launch Thermo-Calc with the new or updated version, the splash
screen hides the Import User Settings dialog box. In order to proceed you
need to click the splash screen and then click Yes or No in the dialog box.

P

pr

If you did not get your license file see "Request a License File from
Thermo-Calc Software" on page 67.
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Custom Standalone Installations

If:) "About the Thermo-Calc Components Being Installed" on page 8

Use the Custom option to have more control over what component features to include or
exclude, for example, to exclude an SDK.

This topic describes how to do a custom installation on a standalone computer for either a
Windows or Linux operating system. These steps assume you have completed these sections:

e "First Steps of Installation" on page 20

e Steps 1to 3 of a "Full Standalone Installations" on page 36 where you request your
license file, download the software and then have started to set up the program up to
the Select Installation Mode window.

Step 1. Select the Installation Mode and the Components to Include
or Exclude

Ij:) "About the Thermo-Calc Components Being Installed" on page 8

1. Inthe Select installation mode window click Custom (the option appears greyed out,
but it is available to select). Click Next.

Full Metwork Client

Install all features

O

Enter the name or [P number of the licensing server

Custom
Choose which features to install

2. On the Specify Configuration window the Create Shortcut on Desktop checkbox is
selected by default. Click Next.
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3. Inthe Select Components window, click to select or deselect the checkboxes as needed.
Click Next.

F:-Y Setup

Select Components

Select the compeonents you want to inst:
continue,

Thermo-Calc

Databases

Additive Manufacturing
TC-Python

] TC-Teolbox for MATLAR (R)
TC-API

TC-Interface

I Step 2. Set the Installation Directory and Choose the License File

1. In the Installation Directory window, either accept the default path or enter a path to
where you want to install the software (see "Installation Default Directories and the
License File " on page 21). Click the file button [® to Browse for Folder and navigate to
another directory.

Installation Directory

Please specify the directory where Therme-Calc will be installed.

Installation Directory | [SE G [E TN STENE i S oF 1[4 <~ varsion

[% To prevent errors, leave this field blank if you do not have a license file yet.

2. Inthe Choose Setup Type window, click Standalone.
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Choose Setup Type

Select one of the following setup types.
See installation guide for detailed description of the choices.

Standalone

Choose a license file C:\Users\amanda\DownI0ads\|servrc| | e

Network Client

Enter name or IP number of the licensing server

In the Choose a license file field enter the path to your license file (called Iservrc) or
click the file button [ to navigate to a location on the computer and open the file.

TC-Python is installed for all users even if you do not have a license. The Install TC-
Python window is a reminder that additional installation procedures are required after
Thermo-Calc is installed. See the TC-Python Installation Guide for details.

I Step 3. Install the Software and Start Using Thermo-Calc

1.

2.

In the Ready to Install window click Next.

I,L_,; See the separate instructions for TC-Toolbox for MATLAB®.

Click Finish and start using Thermo-Calc. For Linux users, log out and log back in to finish
the installation.

macOS installations and if you have previous Thermo-Calc installations: When you
launch Thermo-Calc with the new or updated version, the splash screen hides the
Import User Settings dialog box. In order to proceed you need to click the splash
screen and then click Yes or No in the dialog box.

P

pr

If you did not get your license file see "Request a License File from Thermo-Calc
Software" on page 67.
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Add New Components to an Existing Installation

If you want to add new components to an existing Thermo-Calc installation (for example, you
purchased a license for TC-Toolbox for MATLAB®), run the installation file again as in Step 3 of
"Full Standalone Installations" on page 36.

1. For all OS you need to have administrative level rights. For example in Windows, when
you double-click the executable Thermo-Calc installation .exe file to launch the Setup
program.

[% Linux OS: If Thermo-Calc was not installed by root the first time, then
administrative rights are not required.

2. Click Next. Click to accept the license agreement.
3. Select the additional component(s) to install.

4. Click Next to start the installation, which adds the new component(s).

[% Use the Uninstall program to remove components. See "Uninstalling Thermo-Calc"
on page 151 or "Uninstalling TC-Toolbox for MATLAB®" on page 114.
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Network Client Installations

This installation type is available for all operating systems, however for macOS the License
Server must be run on a Windows or Linux computer. It is applicable to the consolidated and
distributed network types of installations as well as for the licensing installation on a server
network.

O "About the Thermo-Calc Components Being Installed" on page 8

In this section:

Full Network Client Installations ... 45
Windows: About Installing the License Manager ... ... 47
Windows: Installing the Sentinel RMS License Manager ... 49
Linux: About Installing the License Server ... . . 52
Linux: Installing the Sentinel RMS License Server ... 55
Thin Client Installations ...l 58
Custom Network Client Installations ... 61
Unattended Network Client Installations ... ... 64

Network Client Installations | 44 of 152



Network Client Installations

Full Network Client Installations

The following outlines how to do a full network client installation.

I Step 1. Install the Sentinel RMS Management License Software

Follow the instructions for your operating system:

Windows

¢ "Windows: About Installing the License Manager" on page 47

¢ "Windows: Installing the Sentinel RMS License Manager" on page 49

Linux

e "Linux: About Installing the License Server" on page 52

¢ "Linux: Installing the Sentinel RMS License Server" on page 55

I Step 2. Complete Steps 1 to 3 of a Full Standalone Installation

These steps assume you have completed the instructions for "Full Standalone Installations"” on
page 36 to download and run the software up to the Select Installation Mode window. It is up
to you whether you get the computer information for the license files before or after installing
the software.

I Step 3. Choose the Installation Type and Enter the Computer Server
Details

(:) "About the Thermo-Calc Components Being Installed" on page 8

1. Inthe Select Installation Mode window click Full Network Client to Install all features
(the option appears greyed out, but it is available to select).

If you want to exclude a component (perhaps one of the SDKs), then use
:@: the Custom option and see "Custom Network Client Installations" on
page 61.
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In the field, enter the name or IP number of the computer where the licensing software
is installed. Click Next.

Full Metwork Client

Install all features

Enter the name or IP number of the licensing server |

O]

TC-Python is installed for all users even if you do not have a license. The Install
TC-Python window is a reminder that additional installation procedures are required
after Thermo-Calc is installed. See the TC-Python Installation Guide for details.

In the Ready to Install window click Next.

When the Completing the Thermo-Calc Setup Wizard window opens, click Finish. For
Linux users, log out and log back in to start using Thermo-Calc.

macOS installations and if you have previous Thermo-Calc installations:

[% When you launch Thermo-Calc with the new or updated version, the splash
screen hides the Import User Settings dialog box. In order to proceed you
need to click the splash screen and then click Yes or No in the dialog box.

If you did not get your Thermo-Calc license file see "Request a License File from
Thermo-Calc Software" on page 67.
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Windows: About Installing the License Manager

' )

If you have previously installed an older version of Sentinel RMS License Manager,
[ youmustfirst uninstall the old version then reboot the server before starting with
a new installation.

The Sentinel RMS License Manager service supplies the client computers in your network with
license tokens when it runs Thermo-Calc software. The Sentinel RMS License Manager software
is installed on a computer that acts as a license server in your network. This is related to "Full
Network Client Installations" on page 45 and administrative rights are required for all steps.

;@; Remember to collect subnet information before beginning. See "Subnet
e Information for Network Licenses" on page 31.

A network license can only be used on one specific computer that hosts the
[% License Manager. The network license determines which client computers receive
license tokens using the IP addresses and IP ranges.

I Supported Windows Versions

These Windows operating systems are supported for the installation of Sentinel RMS License
Manager. When ready, go to "Windows: Installing the Sentinel RMS License Manager" on
page 49.

[% For macQS, the Sentinel RMS License software is installed on a Windows or Linux
computer server where the Thermo-Calc license file must also be located.

Windows 32-bit Operating Systems
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e Windows 7

e Windows 8.1

e Windows 10 v1909

e Windows Server 2008

Windows 64-bit Operating Systems

e Windows 7

e Windows 8.1

e Windows 10 v1909

e Windows Server 2008

e Windows Server 2008 R2
e Windows Server 2012

e Windows Server 2012 R2
e Windows Server 2016

e Windows Server 2019
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Windows: Installing the Sentinel RMS License Manager

[% First review "Windows: About Installing the License Manager" on page 47. Then if
this is a new installation of the Sentinel RMS License Manager, start with Step 2.

Step 1. Uninstall Any Older Versions of Sentinel RMS License
Manager

1. With Administrator rights, log onto the server that hosts the Sentinel RMS License
Manager.

2. Save a copy of the license file LSERVRC found in the default directory—the license file
can be saved as a text file: c:\Program Files (x86)\Common
Files\SafeNetSentinel\Sentinel RMS License Manager\WinNT\.

After saving the existing license file and uninstalling the old version of
Sentinel RMS, ensure you delete the old license file (LSERVRC) in the above
folder. This license is not required anymore.

3. Reboot the computer hosting the Sentinel RMS License Manager.

4. Continue with the installation and use the preselected default settings.

I Step 2. Download and Install Thermo-Calc

This step is not required to complete the server installation, however some administrators may
want to do it at this point.

1. Download Thermo-Calc.

e Web downloads: For web links sent in an email from Thermo-Calc Software, go
to the URL and log in with the information provided to download the software.

e DVD installations: Insert the DVD and follow the instructions.

2. Install Thermo-Calc. For testing purposes, and in order to confirm the installation is
working correctly, install the Thermo-Calc software on the same computer as the
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Sentinel RMS License Manager. If required after testing, Thermo-Calc can always be
uninstalled.

| Step 3. Install the Sentinel RMS License Manager Software

1. From the download, extract the files 1icense server win 9.7.zipand LS tools

win.zip.

2. Right-click setup.exe and select Run as Administrator from the menu.

I Step 4. Choose the Installation Directory

1. Click to accept the license agreement.

2. Enter your User Name and Organization and select to install the License Manager for All
users.

3. Inthe Destination Folder window click Next to accept the suggested destination
directory or Change to select another directory.

I Step 5. Choose the Setup Type and Install the Software

1. Inthe Setup Type window, select Complete. Click Next.

2. Select the Unblock the system firewall for the Sentinel RMS License Manager
checkbox.

m Selecting the checkbox is required to run Thermo-Calc.

3. Click Next and then Install.
4. Click Finish to exit the InstallShield Wizard.

| Step 6. Install the Thermo-Calc Network License Using WIAdmin

[% Only the WIAdmin tool can be used to update the network license used by the
License Manager.
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Save the source file containing the license code. The source file can be kept as a .txt file
Go to the previously saved file s tools win.zip.

Right-click the file wimadmin.exe and select Run as Administrator from the menu.

If the license server is not found under subnet servers, go to Edit - Defined Server List.
Enter the host name or IP address of the license server.

Click Add and then OK.

Click View - Refresh All to update the list.

In the left main window right-click the name of a License Manager.

S O O i o o

From the menu select Add Feature - From a File - To Server and its File.

=
o

To add the license from a file, select From a File. This permanently adds the license code
to the License Manager license file as well as to the License Manager memory.

11. Inthe windows that open, browse to the source file that contains the license code and
click Open.

I Step 7. Install Additional Tool Options

If:jl "Sentinel RMS License 9.7 Tools" on page 127
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Linux: About Installing the License Server

The Sentinel RMS License Server service supplies the client computers in your network with
license tokens when it runs Thermo-Calc software. The Sentinel RMS License Server software is
installed on a computer that acts as a license server in your network. This is related to "Full
Network Client Installations" on page 45.

I Preparing for Installation

Read and be aware of the following before you begin the section "Linux: Installing the Sentinel
RMS License Server" on page 55.

- Remember to collect subnet information before beginning. See "Subnet
e Information for Network Licenses" on page 31.

Uninstall Older Versions of the License Server

¢ Older versions of the License Server must be stopped by with 1srvdown before running
the new installation. This is Step 1 in "Linux: Installing the Sentinel RMS License Server"
on page 55.

¢ If you have a license server: Upgrade your license server if the new one is a higher
version than the present one. Clients work with newer license servers (managers) but
not necessarily with ones older than the client.

Requires Root Access or sudoers List

Root access to your computer is required or you need to be on the sudoers list.

Linux 32-bit Installations on a 64-bit OS

m To run a license server 32-bit on a Linux 64-bit OS, 32-bit library support is needed.
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Thermo-Calc License File

m The name of the license file must be in lower case letters (Iservrc) because Linux
commands and operations are case-sensitive.

¢ You need a valid Iservrc network license file supplied by Thermo-Calc Software
("Requesting the License File for Windows or Linux" on page 69) as well as the actual
License Server—a file (program) called Iserv.

e The Thermo-Calc license file needs to be readable and writable by the license server
(license manager).

Differences Between 32- and 64-bit Scripts

Sentinel RMS License Server version 9.7 supports both 32- and 64-bit. However, when writing
scripts be aware of script naming and do not mix the scripts.

e All 32-bit scripts are named <script_name>, for example restart lserv

e All 64-bit scripts are named <script_name>64, for example, restart lservé64

It is not possible to use Linux 32-bit scripts/tools to manage license server 64-bit
E] and vice versa, you cannot use Linux 64-bit scripts/tools to manage license server
32-bit

openSUSE Administration (sudo) Users

Note the following if you are a sudo user (administrator) in openSUSE installing Thermo-Calc
using this command:

sudo ./Thermo-Calc-linux-<full-version-number>.run

When this command is used, you will do a text-based installation instead of having a graphical
interface to guide you. The information is the same, just without the user interface.
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i
"Q“

For example, the <full-version-number> is not just 202443, it is what is found in the
Help - About window in Thermo-Calc and it changes every release. You can find
the current full version number listed on our website.

I Supported Linux Operating Systems and Versions

S

For macQS, the Sentinel RMS License software is installed on a Windows or Linux
computer server where the Thermo-Calc license file must also be located.

Both Linux 32-bit and 64-bit operating systems are supported for the installation of Sentinel
RMS License Server.

Red Hat Enterprise Linux (RHEL) 7.x
Red Hat Enterprise Linux (RHEL) 8.x
SUSE Linux Enterprise Server (SLES)12.x
SUSE Linux Enterprise Server (SLES) 15.x
Debian Linux 9.x

Debian Linux 10.x

Ubuntu Linux 16.x (LTS)

Ubuntu Linux 18.x (LTS)

Ubuntu Linux 20.x (LTS)

OpenSUSE Leap 42.x

OpenSUSE Leap 15.x
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Linux: Installing the Sentinel RMS License Server

[% First review "Linux: About Installing the License Server" on page 52. Then if this is a
new installation of the Sentinel RMS License Server, start with Step 2.

Sentinel RMS License Server version 9.7 supports both 32- and 64-bit. However, when writing
scripts be aware of script naming and do not mix the scripts.

e All 32-bit scripts are named <script_name>, for example restart lserv

e All 64-bit scripts are named <script_name>64, for example, restart lservé64

It is not possible to use Linux 32-bit scripts/tools to manage license server 64-bit
E] and vice versa, you cannot use Linux 64-bit scripts/tools to manage license server
32-bit

\ J

I Step 1. Stop Older Versions of the Sentinel RMS License Server

1. To stop an old version of the License Server already running, go to the directory where
the old file is found, and enter the commands:

e 32-bit license server

>chmod +x <lsrvdown>

>./1lsrvdown <host name>

e 64-bit license server

>chmod +x <lsrvdown64>

>./lsrvdown64 <host name>

2. Edit existing scripts that start the older version of the License Server so that they start
the newer version instead.

For more information about the Iservdown utility, go to
https://docs.sentinel.thalesgroup.com/softwareandservices/rms/
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I Step 2. Write a Script to Start the License Server

The following is an excerpt from the template script for starting the License Server found in the
restart_lserv file.

Replace the paths for LICENSE_SERVER_DIR, LICENSE_FILE_DIR and LOG_DIR to match your
system. Save it as a script:
# set the directory where the executables are located
LICENSE SERVER DIR=/usr/local/Thermo-Calc/2024a/Licensing-files
# set the directory of the license file lservrc
LICENSE FILE DIR=/usr/local/Thermo-Calc/2024a/Licensing-files
# set the directory where you wish to save the log-files
LOG DIR=/tmp
# stop the running server
# (omit this line if calling this script at startup)
$LICENSE SERVER DIR/lsrvdown $HOSTNAME
# start the license server

SLICENSE SERVER DIR/lserv -s SLICENSE FILE DIR/lservrc -1 SLOG DIR/lserv use.log -f
$SLOG DIR/lserv_err.log

I Step 3. Confirm the HOSTNAME variable and open the UDP port

The hostname should always correspond to the DNS record verify this by doing the following.

1. Before starting the License Server make sure that the value of the SHOSTNAME variable
is correct. This value can be shown by typing the > nslookup $HOSTNAME command in
the terminal window:

The value should be the same IP address that is shown when you use the ifconfig
command.

2. Open the UDP port 5093 in your firewall. In case you have installed SELinux you might
also need to disable it by setting SELINUX=permissive in the /etc/selinux/config file.

I Step 4. Start the License Server

1. To start the License Server, run the script created as root. Enter these commands in the
console:
> chmod +x <name of script file>

> ./<name of script file>
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2. If you want the License Server to start when you boot the system, put a copy of the start
script under /etc/rc.d/init.d and start the script from the file /etc/rc.d/rc.local.

I Step 5. Install Additional Tool Options

{:) "Sentinel RMS License 9.7 Tools" on page 127
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Thin Client Installations

This topic describes how you install a thin Thermo-Calc client to run Thermo-Calc from a file
server. It is applicable to consolidated and distributed network installations for either a
Windows or Linux operating system.

I Installation Requirements

¢ You need access to the directory where Thermo-Calc is installed on the file server.
¢ You need the IP number or name of the computer where the license file is installed.

e For Linux you may have to disable your firewall. If SELinux is installed, try disabling it by
setting SELINUX=permissive in /etc/selinux/config.

I Windows Installations

The following details may also be of use to those installing in a Windows environment.

e Requests license server name or address and sets LSHOST as a user environment
variable accordingly.

e Sets TC<version>_HOME (where <version> is the software version, e.g. TC22A_HOME) as
a user environment variable to point to the location from which the thin client installer
is running.

The default folders where documents, materials files, examples, and other folders
that sometimes require additional licenses are installed under Public Documents
for ALL USERS. See "Installation Default Directory: Windows" on page 22.

How to Install a Thin Client on Windows

1. Map the file server share as a network drive so that it gets an assigned drive letter (e.g.
E:).

2. Open the \Thermo-Calc\<version>\ directory on the file server, where version is the
current version of the software.

3. Open the directory Thin-client. Double-click the Thermo-calc-client-windows-

<version>.exe file.
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Click to accept the terms of the license agreement. Click Next.

Enter the name or IP number of where the license file and the License Manager
software is installed. Click Next.

By default the Create Shortcuts on Desktop checkbox is selected. Click Next.

[% The shortcuts to the program are added to the user's Windows roaming
profile as well as placed on the user's Desktop (not the system's).

In the Ready to Install window, click Next.

8. Click Finish. To start Thermo-Calc find the program on the server and start it from there.

I How to Install a Thin Client on Linux

1.

2.

Add the following to the smb.conf file, where <user> is your user name:
[public]
path=/home/<user>/Thermo Calc/2024a
public=yes
writable=yes
comment=smb share
guest OK=yes

force user=<user>

From the client, mount the directory on the server computer that contains the
Thermo-Calc server installation (by default, this directory is called
/Thermo-Calc/2024a). How the directory is mounted depends on the Linux distribution
being used as well as how the Thermo-Calc directory on the server computer is shared.
Use the Linux command mount. For example:

> mkdir public

> sudo mount -t cifs //ip number server computer/public ./public -o
user=<user>

Open the mounted directory on your computer, and run client-install-linux-
x64.run Of client-install-1linux-x86.run in the /Thin-client directory.
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If you do this from the terminal window, use the following to start the installation
(assuming that the file server is a 64-bit computer):

> ./client-install-linux-x64.run

Click Forward and click to select the license agreement. Click Forward.
Enter the name or IP number of the License Server. Click Forward.

If you are installing as a non-root user, by default, the Create Shortcuts on Desktop
checkbox is selected. Click Forward.

In the Ready to Install window click Forward.

Click Finish. Log out and log back in to start using Thermo-Calc.
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Custom Network Client Installations

This installation type is available for all operating systems, however for macOS the License
Server must be run on a Windows or Linux computer.The requirements are the same as for a
full client installation.

I Step 1. Install the Licensing Software
Follow the instructions for your operating system:

e "Windows: About Installing the License Manager" on page 47, or

e "Linux: About Installing the License Server" on page 52

I Step 2. Complete Steps 1 to 4 of a Full Standalone Installation

Follow the instructions for "Full Standalone Installations" on page 36 to download and run the
software. It is up to you whether you get the computer information for the license files before
or after installing the software.

Step 3. Select the Installation Mode and the Components to Include
or Exclude

{:) "About the Thermo-Calc Components Being Installed" on page 8

1. Inthe Select installation mode window click Custom (the option appears greyed out,
but it is available to select). Click Next.

Full Metwork Client

Install all features

O

Enter the name or [P number of the licensing server

Custom

Choose which features to install

2. On the Specify Configuration window the Create Shortcut on Desktop checkbox is
selected by default. Click Next.
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3. Inthe Select Components window, click to select or deselect the checkboxes as needed.
Click Next.

F:-Y Setup

Select Components

Select the compeonents you want to inst:
continue,

Thermo-Calc

Databases

Additive Manufacturing
TC-Python

] TC-Teolbox for MATLAR (R)
TC-API

TC-Interface

I Step 4. Set the Installation Directory and the File Path to the License

1. Inthe Installation Directory window, either accept the default path or enter a path to
where you want to install the software (see "Installation Default Directories and the
License File " on page 21). Click the file button ¥ to Browse for Folder and navigate to
another directory. Click Next.

Installation Directory

Please specify the directory where Thermo-Calc will be installed.

Installation Directory | [SENGT e TR N SIEANNE 0 o (4) < varsion™

[% To prevent errors, leave this field blank if you do not have a license file yet.
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2. Inthe Choose Setup Type window, click Network Client and enter the name or IP
number of the computer where the licensing software is installed. Click Next.

Choose Setup Type

Select one of the following setup types.
See installation guide for detailed description of the choices.

Standalone

@]

Choose a license file Ch\Users\amanda\Downloads\LSERYRC

Metwork Client

@® o
Enter name or IP number of the licensing server |

If you have selected to install TC-Python there is a reminder window that
additional installation procedures are required after Thermo-Calc is
installed. See the TC-Python Installation Guide.

I Step 5. Install the Software and Start Using Thermo-Calc
1. Inthe Ready to Install window click Next.

{_F_-} See the separate instructions for TC-Toolbox for MATLAB®.

2. Click Finish and start using Thermo-Calc. For Linux users, log out and log back in to finish
the installation.

macOS installations and if you have previous Thermo-Calc installations: When you

[% launch Thermo-Calc with the new or updated version, the splash screen hides the
Import User Settings dialog box. In order to proceed you need to click the splash
screen and then click Yes or No in the dialog box.

If you did not get your license file see "Request a License File from Thermo-Calc
= Software" on page 67.
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Unattended Network Client Installations

Terminology note: The use of the term license server (lower case letters) is

[% applicable to the option files as described in this section. For the purposes of the
step-by-step instructions it is not used to refer to the type of network installation
that runs the licensing software.

Sometimes it is convenient to install Thermo-Calc network clients without providing user input
after the installation is initiated (an unattended network client installation). This is available for
Windows and Linux operating systems.

[% Make sure you know the name or IP number of the computer where the licensing
software and the license file are to be installed.

I Step 1. Create an Option File in a Text Editor to Enter the Options

The following is an example of an option file for a custom network client installation, where
<name/IP number> is the name or IP number of the computer where the license file is installed:
installation mode=custom
setup_ type=client
enable-components=thermo,databases, tq, tcapi, toolbox, tcpython
icons=1

license server=<name/IP number>

Below is a shorter example, specifying that a full Thermo-Calc network client should be
installed:

installation mode=full client

license server=<name/IP number>

I Step 2. Go to the Directory Where the Installation File is Saved

[% Thermo-Calc can only be installed in unattended mode from the command line
prompt.

Start the installation in unattended mode using the option file created with this command:
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e For Windows: <installationfile>.exe --mode unattended --optionfile

<path\optionfile>

e For Linux: <installationfile>.run --mode unattended --optionfile
<path/optionfile>

To see other options when you start the Thermo-Calc installation program from the command
line prompt, run this command:

e For Windows: <installationfile>.exe --help

e For linux: <installationfile>.run --help

Unattended Network Client Installations | 65 of 152



Request License Files

Request License Files

In this section:

Request a License File from Thermo-Calc Software ... .. 67
Getting License Information Using Thermo-Calc ... 68
Requesting the License File for Windows or Linux ... 69
Requesting the License File for macOS ... . . 71
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Request a License File from Thermo-Calc Software

The following explains how to retrieve the necessary diagnostic and network adaptor
information about your computer and then send an email to Thermo-Calc Software to get your
license file(s) containing the license key(s).

To set up the correct licensing:
1. Make a note of your company or organization’s site number. You can find the site
number on an invoice or any correspondence from Thermo-Calc Software.
2. Retrieve your computer diagnostic and network adapter information.
3. Email Thermo-Calc Software with this information.

4. A Thermo-Calc Software representative emails you the license file. Save the license file
Iservrc (there is no file suffix) to a location where you can easily access it later.

{P} Thermo-Calc Support Center on our website
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Getting License Information Using Thermo-Calc

If you have already installed Thermo-Calc, you can view the license information in the GUI.
Select Help - 7 show License Info.

In Console Mode you can run the SYS module command DISPLAY_LICENSE_INFO.

1. Open Thermo-Calc.
2. Click Switch to Console Mode.

Ay File Tools Window Help

A EEH A

3. Atthe sys: prompt, enter bIspPLAY LICENSE INFO.You can output the information to a
FILE Or to the sCREEN.

SYS5:DISPLAY LICENSE TNFO

QUTFUT TO SCREEN OR FILE fSCREENf:SCREENi

4. For both options, the information is displayed on screen. Copy the section containing
the Ethernet and IP address. You can save it to a text file or paste it directly into an
email. If you choose rILE as the output, then you can attach the file to an email.
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Requesting the License File for Windows or Linux

r

Upgrades to a new version of Thermo-Calc: Skip this section if you are upgrading

[% to a new version of Thermo-Calc and (and you have a maintenance plan). Your
license is sent to you in an email from Thermo-Calc Software AB. Save it to your
computer to use during software installation.

1. To access the computer information you need to provide to get a license, start
Thermo-Calc and select Help - Show License Info.

‘u License Information

License diagnoatics program
build: 26030 created: Tue May 03 05:30:22 2022

Log generaced at: 13-05-2022 14:34:42
Zafenet environment variables

LSBOST: HO-HET

ILSEEVRC: C:\Program Files/Thermo-Calc/lasrvre
Local {cliesnt) info

1.1 14.P.1."H TC-LT-05

licenss veraion: 8.5.1.0017

2. Copy the information from the License Information window. A lot of information may
be shown below the initial screen, so make sure you scroll down to the end when you
select and copy the window's contents. (Alternatively, you can copy the same
information from the console by using the SYS module command DISPLAY_LICENSE_
INFO.)

3. Send an email to support@thermocalc.com. Make sure to include the following in the
subject line:

License diagnostic information from <Name> where Name is replaced with your name,
the organization name and the Site Number. You can find the five-digit site number on
an invoice or any correspondence from Thermo-Calc Software.

Designated Site 12345 |
XYZ Company

“Dpt. of Material Science
900 Main Street
Stockholm 11190
SWEDEN
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Request License Files

To: support@thermocalc.com

Cc:

License diagnostic information from Jane Smith, XYZ Company, Site 12345

Add attachments | 7 tcloglog (7.3 KB} (%

4. A representative from Thermo-Calc Software replies to the email and attaches your
license file(s).

5. Save the license file(s) to your computer or network.

Requesting the License File for Windows or Linux | 70 of 152



Request License Files

Requesting the License File for macOS

7

S

Upgrades to a new version of Thermo-Calc: Skip this section if you are upgrading
to a new version of Thermo-Calc and (and you have a maintenance plan). Your
license is sent to you in an email from Thermo-Calc Software AB. Save it to your
computer to use during software installation.

From the Apple main menu, select System Preferences.
Click Network.

In the left column select Ethernet or Built-in Ethernet (do not select a WiFi connection
as a local static MAC address is required).

Click Advanced - Hardware. The Network window shows you the MAC Address. For
example, the MAC address (the host ID) might be 3¢:07:54:28:5f:72.

Network

P

e+ Ethernet

TCP/IP  DNS  WINS B02.1X  Proxies m

MAC Address: 3c:07:54:28:5f.72

Configure:  Automatically d
Speed:
Duplex: half-duplex

MTU: Standard (1500)

Send an email to support@thermocalc.com and copy and paste the MAC address into
the body of the email. Make sure to include the following in the subject line:

License diagnostic information from <Name> where Name is replaced with your name,
the organisation name and the Site Number. You can find the five-digit site number on
an invoice or any correspondence from Thermo-Calc Software.

Designated Site 12345 |
XYZ Company

~Dpt. of Material Science
900 Main Street
Stockholm 11190
SWEDEN
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To: support@thermocalc.com

Cc:

License diagnostic information from Jane Smith, XYZ Company, Site 12345

Add attachments | 7 tcloglog (7.3 KB} (%

6. Arepresentative from Thermo-Calc Software replies to the email address provided and
attaches your license file or files.

7. Save your license file to your computer or network.
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Quick Install Guides

In this section:

Windows® Standalone Quick Install Guide ... 74

macOS® Standalone Quick Install GUIde ... 78
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Windows® Standalone Quick Install Guide

This quick guide helps you do a full standalone installation. A standalone installation is used
with the Single-User Node-Locked License (SUNLL), where the software and the license file are
together on one computer.

This guide is applicable to:

¢ Windows operating systems
e Full Standalone installation (SUNLL)

e Upgrading to a new standalone version of Thermo-Calc (maintenance plan only)

Other Installations

For instructions about other operating systems, network installations, or installing
X% an SDK (e.g. TC-Python or TC-Toolbox for MATLAB®) search the Thermo-Calc
ef” Installation Guide, which is also available on our website. You can also review the
Licensing Options included on our website.

I Request a License File

4 N

Upgrades to a new version of Thermo-Calc: Skip this section if you are upgrading

[% to a new version of Thermo-Calc and (and you have a maintenance plan). Your
license is sent to you in an email from Thermo-Calc Software AB. Save it to your
computer to use during software installation.
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1. To access the computer information you need to provide to get a license, start
Thermo-Calc and select Help - Show License Info.

Y. License Information

License diagnoatics program
build: 26030 created: Tue May 03 05:30:22 2022

Log gensrated at: 13=-05=2022 la:34:42
Safenet environment variables
LSHOST: HO-NET
LSERVRC: C:\Program Files/Thermo-Cale/lservre

Local {cliesnt) info
ROSTRARS : TC-LT-05
license wversion: §.5.1.0017

2. Copy the information from the License Information window. A lot of information may
be shown below the initial screen, so make sure you scroll down to the end when you
select and copy the window's contents. (Alternatively, you can copy the same
information from the console by using the SYS module command DISPLAY_LICENSE_

INFO.)

3. Send an email to support@thermocalc.com. Make sure to include the following in the
subject line:

License diagnostic information from <Name> where Name is replaced with your name,
the organization name and the Site Number. You can find the five-digit site number on
an invoice or any correspondence from Thermo-Calc Software.

Designated Site 12345 |
XYZ Company

“Dpt. of Material Science
900 Main Street
Stockholm 11190
SWEDEN

To: support@thermocalc.com

Ce:
License diagnestic information from Jane Smith, XYZ Company, Site 12345

Add attachments | ] tcloglog (7.3 KB) [x

4. A representative from Thermo-Calc Software replies to the email and attaches your
license file(s).

5. Save the license file(s) to your computer or network.
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I Install the Software

Download and Run your Thermo-Calc Installation Software

Q

Administrative rights are required to complete this installation.

For web links sent in an email from Thermo-Calc Software, go to the URL and log in with
the information provided. Then navigate to the Windows folder and click the link to
download the software.

Go to the folder where you downloaded the software. Double-click the .exe file to
launch the Setup program.

On the Setup-Thermo-Calc window click Next.

On the License Agreement window click to accept the license agreement. Click Next.

Select the Installation Mode

1.

2.

In the Select Installation Mode window click Full Standalone: Install all features.

TC-Python is installed when the Full Standalone or Full Network Client
option is chosen, but there are additional steps required as described
separately for this SDK.

For a Full Standalone installation, in the Choose a license file field either enter the file

path or click the file button = to navigate to where you saved the license file emailed
to you from Thermo-Calc Software.

2 Setup
Select Installation Mode

Full Standalone

Install all features
®

Choose a license file C:hUserstamanda'Downloads\LSERVRJ
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[% The license file is called Iservrc. Click Next. To prevent errors, leave this
field blank if you did not get a license file yet.

TC-Python is installed for all users even if you do not have a license. The
[% Install TC-Python window is a reminder that additional installation

procedures are required after Thermo-Calc is installed. See the TC-Python
Installation Guide.

3. Inthe Ready to Install window click Next. Click Finish and start using Thermo-Calc.
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macOS® Standalone Quick Install Guide

This quick guide helps you do a full standalone installation. A standalone installation is used
with the Single-User Node-Locked License (SUNLL), where the software and the license file are
together on one computer.

This guide is applicable to:

¢ macOS
e Full Standalone installation (SUNLL)

e Upgrading to a new standalone version of Thermo-Calc (maintenance plan only)

Other Installations

For instructions about other operating systems, network installations, or installing
X% an SDK (e.g. TC-Python or TC-Toolbox for MATLAB®) search the Thermo-Calc
A Installation Guide, which is also available on our website. You can also review the
Licensing Options included on our website.

I Request a License File

4 N

Upgrades to a new version of Thermo-Calc: Skip this section if you are upgrading

[% to a new version of Thermo-Calc and (and you have a maintenance plan). Your
license is sent to you in an email from Thermo-Calc Software AB. Save it to your
computer to use during software installation.

1. From the Apple main menu, select System Preferences.
2. Click Network.

3. Inthe left column select Ethernet or Built-in Ethernet (do not select a WiFi connection
as a local static MAC address is required).

4. Click Advanced - Hardware. The Network window shows you the MAC Address. For
example, the MAC address (the host ID) might be 3¢:07:54:28:5f:72.
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Network

PR

‘e Ethernet

TCPAP DNS WINS B02.1X Proxies [ EVEIEH

MAC Address: 3c:07:54:28:5f.72

Configure:  Automatically d
Speed:
Duplex: half-duplex

MTU: Standard (1500)

5. Send an email to support@thermocalc.com and copy and paste the MAC address into
the body of the email. Make sure to include the following in the subject line:

License diagnostic information from <Name> where Name is replaced with your name,
the organisation name and the Site Number. You can find the five-digit site number on
an invoice or any correspondence from Thermo-Calc Software.

Designated Site 12345 |
XYZ Company

900 Main Street
Stockholm 11190
SWEDEN

To: support@thermocalc.com

Ce=
License diagnostic information from Jane Smith, XYZ Company, Site 12345

A { ] tclog.log (7.3 KB) (%

6. A representative from Thermo-Calc Software replies to the email address provided and
attaches your license file or files.

7. Save your license file to your computer or network.
| Install the Software
Download and Install XQuartz
The XQuartz open-source X Windows system is required to run Thermo-Calc on macOS X.

1. Inaweb browser go to https://www.macupdate.com or to download it directly from
XQuartz, https://www.xquartz.org/.

2. Inthe Search Mac Apps field, enter XQuartz.

3. Click the XQuartz search result. For example, based on the recent version, the name is
XQuartz-2.7.11.dmg.
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4. Click Download.
5. Double-click the XQuartz.pkg file. Follow the instructions.

6. Click OK when the message about logging out displays and click Close when the installation
is successful.

Download and Run your Thermo-Calc Installation Software

m Administrative rights are required to complete this installation.

1. For web links sent in an email from Thermo-Calc Software, go to the URL and log in with
the information provided. Then navigate to the Mac folder and click the link to
download the software.

2. Double-click the downloaded file to launch the installation.

For macOS and when you first run the installer, you may see a message

that Thermo-Calc-osx-<version> can't be opened because Apple cannot
‘:@:‘ check it for malicious software. If this happens, select Show in Finder.
Then, in the opened Finder window right-click the downloaded file
Thermo-Calc-osx-<version>and select Open.

3. On the Setup-Thermo-Calc window click Next.

4. On the License Agreement window click to accept the license agreement. Click Next.

Select the Installation Mode

1. Inthe Select Installation Mode window click Full Standalone: Install all features.

TC-Python is installed when the Full Standalone or Full Network Client
option is chosen, but there are additional steps required as described
separately for this SDK.
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2. For a Full Standalone installation, in the Choose a license file field either enter the file

path or click the file button ' to navigate to where you saved the license file emailed
to you from Thermo-Calc Software.

A Setup
Select Installation Mode

Full 5tandalene
Install all features
®

Choose a license file C:\Users\amanda\Downloads\LSERVR(]

[% The license file is called Iservrc. Click Next. To prevent errors, leave this
field blank if you did not get a license file yet.

TC-Python is installed for all users even if you do not have a license. The

[% Install TC-Python window is a reminder that additional installation
procedures are required after Thermo-Calc is installed. See the TC-Python
Installation Guide.

3. Inthe Ready to Install window click Next. Click Finish and start using Thermo-Calc.

macOS installations and if you have previous Thermo-Calc installations: When you

[% launch Thermo-Calc with the new or updated version, the splash screen hides the
Import User Settings dialog box. In order to proceed you need to click the splash
screen and then click Yes or No in the dialog box.
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TC-Python Installation Guide

In this section:

About the TC-Python Documentation ... 83
Which TC-Python Installation Should | ChooSe? ... ... 85
Installing TC-Python with a Bundled Python-interpreter ... . ... 86
Installing TC-Python Into a Python-interpreter of Your Choice ... 90
Installation Default Directory: TC-Python ... ... . 94
macOS: Setting Environment Variables ... 95
Fixing Potential Issues with the Environment ... 96
OPtioNal PaCKages ... . oo 97
Updating to a NEWEr VEIrSION ... L 98
TC-Python Diagnostic SCript ... . 99
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About the TC-Python Documentation

r

The TC-Python help is available on the Thermo-Calc website where you can also
:@:‘ access additional resources. You can alternatively access the locally installed
documentation from the Help menu in Thermo-Calc.

Opening the Locally Installed Documentation

1. In Thermo-Calc from the menu, select Help = Manuals Folder.

L File Tools Window
M M B EA © onlineHep Fi

[*] Video Tutorials

Project

|~ Example Files...

_— ,', Thermo-Calc Website

D Eﬁ‘ Show License Info

Iy Proje
LR G Check for Updates

[2; Request Support

0 About

[% You can also navigate to the Manuals folder outside of Thermo-Calc and
based on your operating system installation location.
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2. Inthe window that opens, double-click to open the TC-Python folder.

This PC » Documents » Thermo-Calc » =wersion> » Manuals

~ [ MName

All Thermo-Calc Docurmentation
Database Information Sheets
DATAPLOT Example EXP Files
Diffusion Module (DICTRA)
Installation Guides

Precipitation Medule (TC-PRISMA)
Software Development Kits (5DKs)

[ | TC-Pythen k
TC-Toolbox_MATLAB

3. Double-click the Index HTML file (or any of the HTML files).

G best_practices.html
'E calculations.html
€ genindex.html

€ index.html
'E installation.htrnl

4. The API reference documentation opens as a searchable HTML file in your local browser.
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Which TC-Python Installation Should I Choose?

P A license is required to run TC-Python. Also remember to review the System
Requirements page on our website.

There are these options to install TC-Python.

E See the Videos about TC-Python page for additional learning resources.

Install with the Bundled Python-interpreter

This is a straightforward installation where TC-Python is preinstalled together with some
popular Python packages.

This is the recommended option for new users to TC-Python who may only want to run the
examples. The available preinstalled packages (e.g. numpy, scipy, scikit-learn, pyvista, and
matplotlib) can also be sufficient for many advanced users.

{:) "Installing TC-Python with a Bundled Python-interpreter" on the next page.

{:) "Optional Packages" on page 97

Install with a Python-interpreter of Your Choice

This installation requires additional steps and is the recommended option for more advanced
use and has full flexibility.

{:) "Installing TC-Python Into a Python-interpreter of Your Choice" on page 90.
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Installing TC-Python with a Bundled Python-
interpreter

TC-Python can be installed using a Python-interpreter that is bundled to Thermo-Calc. This
interpreter has TC-Python preinstalled together with some popular Python packages. This is the
recommended option for new users to TC-Python who may only want to run the examples. The
available preinstalled packages (e.g. numpy, scipy, scikit-learn, pyvista, and matplotlib) can also
be sufficient for many advanced users.

The bundled interpreter package is also used to run the Property Models in
Thermo-Calc. Do not make changes to interpreter packages or this can stop

E] Thermo-Calc from working correctly. To fix issues caused by changes to an
interpreter, completely uninstall Thermo-Calc and start over, either with the
bundled interpreter package or using interpreters of your choice.

If you are planning to do more advanced calculations that require other external
:@: packages then you may want to follow these instructions instead: "Installing
TC-Python Into a Python-interpreter of Your Choice" on page 90

Limitations

( )

The following examples cannot be run with the bundled Python-interpreter as
additional packages are required: pyex M 01 Input from file.py (pandas)and
pyex M 02 Output to file.py (pandas, Ixml, h5py).

The bundled Python 3.9.18 interpreter contains the following major packages.

[% If you have recommendations for additional packages to include (see below), send
an email to Thermo-Calc Support.
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Package Version

matplotlib 3.8
numpy 1.26.0
scikit-learn 131
scipy 1.11.3
pyvista 0.42.2
TC-Python 2024a

I Step 1. Install an IDE (Integrated Development Environment)

Any editor can be used to write the Python code, but an IDE is recommended, e.g. PyCharm.
These instructions are based on the use of PyCharm.

Use of an IDE gives you access to code completion, which helps when you use the API as it gives
you the available methods on the objects you are working with.

1. Navigate to the PyCharm website: https://www.jetbrains.com/pycharm/download.

2. Click to choose your OS and then click Download. You can use the Community version
of Pycharm.

3. Follow the instructions. It is recommended you keep all the defaults.

. For Mac installations, you also need to set some environment variables as
described below in "macOS: Setting Environment Variables" on page 95.

I Step 2. Configure PyCharm to Use the Bundled Python-interpreter

Open PyCharm and configure the interpreter:
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1. Go the menu File - Settings.
2. Navigate in the tree to Project: YourProjectName and choose Project Interpreter.

3. Click on the settings symbol close to the Project Interpreter dropdown menu and
choose Add.

4. Select System Interpreter and add the bundled Thermo-Calc Python 3 interpreter,
which is located in a folder based on the operating system:

Operating
system

Path to the bundled Python-interpreter

Windows C:\Program Files\Thermo-Calc\2024a\python\python.exe
Linux /home/UserName/Thermo-Calc/2024a/python/bin/python3
macOS /BApplications/Thermo-Calc-2024a.app/Contents/Resources/python/bin/python3

5. Select the interpreter and confirm.

I Step 3. Run a TC-Python Example

It is recommended that you open one or more of the included examples to both check that the
installation has worked and to start familiarizing yourself with the code.

Open the TC-Python Project in PyCharm

[% When you first open the TC-Python project and examples, it can take a few
moments for the Pycharm IDE to index before some of the options are available.

1. Open PyCharm and then choose File - Open. The first time you open the project you
will need to navigate to the path of the TC-Python installation based on your operating
system.
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Operating
system

Path to the TC-Python folder

Windows C:\Users\UserName\Documents\Thermo-Calc\2024a\SDK\TC-Python
Linux /home/UserName/Thermo-Calc/2024a/SDK/TC-Python
macOS /Users/Shared/Thermo-Calc/2024a/SDK/TC-Python

2. Click the Examples folder and then click OK.

3. From any subfolder:

e Double-click to open an example file to examine the code.

e Right-click an example and choose Run.

If you are not following the recommended approach and create a new project (File
-> New Project...), you need to consider that by default the options to choose the

[% interpreter are hidden within the Create Project window. For this, click Project
Interpreter: New Virtual Environment and in most cases choose your System
Interpreter containing the Python bundled to Thermo-Calc instead of the default
New Virtual Environment.
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Installing TC-Python Into a Python-interpreter of Your
Choice

TC-Python can be installed using a Python-interpreter of your choice. This is the recommended
option for any more advanced usage and provides full flexibility.

If you are new to TC-Python and want to mainly run the examples, then it is
recommended you install the bundled Python-interpreter. The available

':@:' preinstalled packages (e.g. numpy, scipy, scikit-learn, pyvista, and matplotlib) can
also be sufficient for many advanced users. See "Installing TC-Python with a
Bundled Python-interpreter" on page 86.

I Step 1. Install a Python Distribution

[% If you already have a Python distribution installation, version 3.8 or newer, skip
this step.

These instructions are based on using the Anaconda platform for the Python distribution. Install
version 3.8 or newer to be able to work with TC-Python, although it is recommended that you
use the most recent version.

Install Anaconda

1. Navigate to the Anaconda website: https://www.anaconda.com/download/.

2. Click to choose your OS (operating system) and then click Download. Follow the
instructions. It is recommended you keep all the defaults.

| Step 2. Install Thermo-Calc and the TC-Python SDK

1. Install Thermo-Calc.

2. When the installation is complete, open the TC-Python folder that includes the *.whl file
needed for the next step. There is also an Examples folder with Python files you can use
in the IDE to understand and work with TC-Python.

I Step 3. Install TC-Python

(7)  "Updating to a Newer Version" on page 98

L)
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On Windows, it is recommended you use the Anaconda distribution prompt (i.e. Anaconda),
especially if you have other Python installations.

. Do not use Virtual Environments unless you have a good reason to do so. Also see
"Fixing Potential Issues with the Environment" on page 96.

1. Open the command line. For example, in Anaconda on a Windows OS, go to Start -
Anaconda - Anaconda Prompt.

Anaconda3 (64-bit)

2. At the command line, enter the following. Make sure there are no spaces at the end of
the string or in the folder name or it will not run:

pip install <path to the TC-Python folder>/TC Python-<version>-
py3-none-any.whl

[% On Linux, and depending on the interpreter, pip3 is typically used.

Operating
system

Path to the TC-Python folder

Windows C:\Users\UserName\Documents\Thermo-Calc\2024a\SDK\TC-Python
Linux /home/UserName/Thermo-Calc/2024a/SDK/TC-Python
macOS /Users/Shared/Thermo-Calc/2024a/SDK/TC-Python
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3. Press <Enter>. When the process is completed, there is a confirmation that TC-Python is
installed.

If your computer is located behind a proxy-server, the default pip-
command will fail with a network connection error. In that case you need
to install the dependency py4j in a special configuration:

pip install -proxy user:password@proxy ip:port py4j jproperties

Go to the TC-Python Help Troubleshooting section for detailed information.
- This can be found on our website or from the installed documentation
I"—> where you can search for "pip install fails" with “Failed to establish a new
network connection” or similar.

I Step 4. Install an IDE (Integrated Development Environment)

Any editor can be used to write the Python code, but an IDE is recommended, e.g. PyCharm.
These instructions are based on the use of PyCharm.

Use of an IDE gives you access to code completion, which helps when you use the API as it gives
you the available methods on the objects you are working with.

1. Navigate to the PyCharm website: https://www.jetbrains.com/pycharm/download.

2. Click to choose your OS and then click Download. You can use the Community version
of Pycharm.

3. Follow the instructions. It is recommended you keep all the defaults.

E] For Mac installations, you also need to set some environment variables as
described below in "macQS: Setting Environment Variables" on page 95.

I Step 5. Open the IDE and Run a TC-Python Example

After you complete all the software installations and set up the pip install path, you are ready
to open the IDE to start working with TC-Python.

It is recommended that you open one or more of the included examples to both check that the
installation has worked and to start familiarizing yourself with the code.
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Open the TC-Python Project in PyCharm

[% When you first open the TC-Python project and examples, it can take a few
moments for the Pycharm IDE to index before some of the options are available.

1. Open PyCharm and then choose File - Open. The first time you open the project you
will need to navigate to the path of the TC-Python installation based on your operating
system.

Operating
system

Path to the TC-Python folder

Windows C:\Users\UserName\Documents\Thermo-Calc\2024a\SDK\TC-Python
Linux /home/UserName/Thermo-Calc/2024a/SDK/TC-Python
macOS /Users/Shared/Thermo-Calc/2024a/SDK/TC-Python

2. Click the Examples folder and then click OK.

3. From any subfolder:

e Double-click to open an example file to examine the code.

* Right-click an example and choose Run.

Also see "Optional Packages" on page 97 if you are using the Additive
Manufacturing Module for simulations.
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Installation Default Directory: TC-Python

These are the default paths to the TC-Python folder based on your operating system.

Operating
system

Path to the TC-Python folder

Windows C:\Users\UserName\Documents\Thermo-Calc\2024a\SDK\TC-Python
Linux /home/UserName/Thermo-Calc/2024a/SDK/TC-Python
macOS /Users/Shared/Thermo-Calc/2024a/SDK/TC-Python

For a bundled Python-interpreter installation, these are the paths to this location based on your
operating system.

Operating
system

Path to the bundled Python-interpreter

Windows C:\Program Files\Thermo-Calc\2024a\python\python.exe
Linux /home/UserName/Thermo-Calc/2024a/python/bin/python3
macOS /Applications/Thermo-Calc-2024a.app/Contents/Resources/python/bin/python3
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macOS: Setting Environment Variables

In order to use TC-Python on Mac you need to set some environment variables.
TC24A HOME=/Applications/Thermo-Calc-2024a.app/Contents/Resources
If you use a license server:
LSHOST=<name-of-the-license-server>

If you have a node-locked license:

LSHOST= NO-NET

LSERVRC=/Users/Shared/Thermo-Calc/lservrc
In PyCharm, you can add environment variables in the configurations.

Select Run - Edit Configurations to open the Run/Debug Configurations window. Enter the
environment variable(s) by clicking the button to the right of the Environment Variables text
field. Now the environment variables(s) will be set for each new configuration by default. The
same way for configuring the environment variables can be used on other operating systems as
if necessary.

™) 1c0s vcs window Help

| | 2 Run "pyex_P_01_Precipitation_Al-5¢_AL3SC’ Shift+F10
® Debug 'pyex_P_01_Precipitation_Al-Sc_AL3SC’ Shift+F9
P Run.. Alt+Shift+F10
# Debug... Alt+Shift+F9

| " Attach to Local Process...

¢ Edit Configurations... k‘
B >

?| Import Test Results
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Fixing Potential Issues with the Environment

In most cases you should run TC-Python within your global Python 3 interpreter and not use
Virtual Environments unless you have a good reason to do so.

If there are problems with the interpreter settings, for example, a common problem when you
first use TC-Python is the message No module named tc_python, which you can resolve in the
Settings window as follows:

1.

N

Go the menu File - Settings.
Navigate in the tree to <Project.YourProjectName> and choose Project Interpreter.

Click on the settings symbol close to the Project Interpreter drop-down menu and
choose Add.

Now choose System Interpreter and add your existing Python 3 interpreter.

Select your added interpreter and confirm.

If you are not following the recommended approach and create a new project (File
-> New Project...), you need to consider that by default the options to choose the
interpreter are hidden within the Create Project window. For this, click Project
Interpreter: New Virtual Environment and in most cases choose your System
Interpreter containing the Python bundled to Thermo-Calc instead of the default
New Virtual Environment.

If you really need to use a Virtual Environment, it is recommended you review the
hints provided in the Best Practices section in the full TC-Python HTML help or
PDF.
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Optional Packages

Plotting results of Additive Manufacturing simulations requires the package pyvista. It is
automatically installed if using the option [am-plotting] during the installation:

pip install <path to the TC-Python folder>/TC Python-<version>-py3-none-any. ,!whl
[am-plotting]

[% The bundled interpreter contains pyvista by default.
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Updating to a Newer Version

' )

If you are using the bundled Python-interpreter automatically installed with
Thermo-Calc, these steps are not required.

These steps are required if you have previously followed the instructions in
"Installing TC-Python Into a Python-interpreter of Your Choice" on page 90.

When updating to a newer version of Thermo-Calc, you always need to also install the latest
version of TC-Python. It is not sufficient to run the installer of Thermo-Calc (except for bundled
versions of the Python interpreter).

pip install <path to the TC-Python folder>/TC Python-<version>-py3-
none-any.whl

In case of problems you may wish to uninstall the previous version of TC-Python in advance:

pip uninstall TC-Python

pip install <path to the TC-Python folder>/TC Python-<version>-py3-
none-any.whl

However, this should not normally be required.

[ [% On Linux typically pip3 is used.

You can check the currently installed version of TC-Python by running:

pip show TC-Python
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TC-Python Diagnostic Script

A diagnostic script is available to help you if you have problems running TC-Python.

'a )

It is important to run the diagnostic script EXACTLY the same way as you run your
E] TC-Python script (in the same IDE, same project, same Python environment, same
Jupyter notebook, etc).

The script automatically prints useful suggestions that, in many cases, will help you to fix the
problem yourself. If you are unable to solve the problem, contact us for support. You can find
the script in these locations:

¢ Miscellaneous example (diagnostics.py)

¢ In the Troubleshooting section of the TC-Python API Reference Documentation. Also
refer to the Best Practices in the same guide to see if there are any other solutions or
tips.

¢ On our website.
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TC-Toolbox for MATLAB® Installation Guide

In this section:

About TC-Toolbox for MATLAB® . 101
TC-Toolbox Documentation ... 102
Installation Default Directory: TC-Toolbox and the Examples ... 104
Installing TC-TOOIbOX ... oo 105
Installing TC-Toolbox with the Custom Option ... .. 107
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Uninstalling TC-Toolbox for MATLAB ® 114
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About TC-Toolbox for MATLAB®

TC-Toolbox for MATLAB® (TC-Toolbox) provides an interface to the commonly used MATLAB®
software for scientific and engineering computing. This software development kit (SDK) is ideal
for fast realization of ideas and visualization of results during research and development
activities. The TC-Toolbox APl includes calculation types available in Thermo-Calc such as single
point equilibrium, property (step) and phase (map) diagrams, Scheil solidification simulations,
as well as all the general Thermo-Calc Property Models (e.g. yield strength, spinodal, driving
force, etc.).

With the addition of licenses for the applicable software and databases, you can further
maximize your integration with MATLAB® to include the capabilities of the Steel Model Library
Property Models (e.g. bainite, pearlite, etc.), as well as access the range of functionality
included with the Diffusion Module (DICTRA) and the Precipitation Module (TC-PRISMA).
Generally, all the functionality available in Graphical Mode or via the TC-Python SDK is
available.

TC-Toolbox for MATLAB® is available on Windows platforms.

A license is required to run TC-Toolbox for MATLAB® and MATLAB® must also be
P installed on your computer prior to the TC-Toolbox installation. Also remember to
review the System Requirements page on our website.
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TC-Toolbox Documentation

There are various locations and formats of the documentation you need related to this SDK.

The TC-Toolbox for MATLAB® API Reference Documentation is available from these
_,@,_ general locations (1) within the MATLAB® environment—both as help and as part
e of the tab completion (2) directly on the Thermo-Calc website, and (3) locally in
the Thermo-Calc installation (Help>Manuals Folder).

API Reference Documentation

The TC-Toolbox for MATLAB® API Reference Documentation is available either as interactive
help (in HTML format or when in MATLAB® using tab completion or accessed via different
menus or key combinations) or as a standalone PDF.

There are these ways to access the content:

e Directly in MATLAB® via the Help menu then under Supplemental Software click
TC-Toolbox. Help is also available when writing code and using the tab completion

feature and/or pressing different key combinations as described in the Best Practices
section of the help.

e From the website: HTML Help or PDF

¢ Locally in a Thermo-Calc installation:

e HTML: Help > Manuals Folder > TC-Toolbox_MATLAB, then click any HTML file.

e PDF: Help > Manuals Folder > Software Development Kits (SDKs), then double-
click to open the TC-Toolbox for MATLAB® APl Programmer Guide. This is a copy
of the HTML API reference documentation.

Installation Instructions

The installation instructions are only included in the Thermo-Calc help (press F1), and in the
PDF version of the main installation guide found, for example:
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e On our website as part of the full Thermo-Calc Installation Guide.

e Once Thermo-Calc is installed:
e Locally in a Thermo-Calc installation: Help > Manuals Folder >Installation

Guides.

e Press F1in Thermo-Calc to search the help.

Thermo-Calc Help (Limited)

For TC-Toolbox, there is limited content included in the Thermo-Calc help (press F1 when in
Thermo-Calc) because it is replaced by the TC-Toolbox for MATLAB® API Reference
Documentation. The exception is installation instructions to describe how to install the SDK.
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Installation Default Directory: TC-Toolbox and the
Examples

The software component and the examples are installed as described below.

This is the default path to the installation folder for the TC-Toolbox component on Windows
operating systems. Be aware that the initial installation files and examples are placed in
Public\Documents, then after opening Thermo-Calc for the first time, these are copied to the
Documents folder for each user. The documentation is installed elsewhere and as described in
"TC-Toolbox Documentation" on page 102.

There are included examples with all TC-Toolbox installations. These are the same as the
examples included with TC-Python although with a different suffix (matex) and prefix (*.m) in
the file name. You can read summaries about the examples as described for TC-Python in the
online help.

Path to the TC-Toolbox folder

Both the installation files AND the examples are installed in the following folders.

The default Windows folders where the TC-Toolbox examples are installed starts with the original installation placing these
under Public Documents for ALL USERS.

For a local user, and after Thermo-Calc is opened for the first time, these files are copied to the user’s Documents folder
where this local copy is associated to the user login. The Public Documents folder always contains the original set of
contents as per the installation.

C:\Users\Public\Public Documents\Thermo-Calc\<version>\SDK\TC-Toolbox-MATLAB

After installing Thermo-Calc, and when you first open the program, the set of folders containing the examples is copied
from the source Public\Documents location into a user Documents folder:

C:\Users\<user>\Documents\Thermo-Calc\<version>\SDK\TC-Toolbox-MATLAB\Examples

E] It is recommended that you work with the files that are copied to the user folder.
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Installing TC-Toolbox

There are automatic or manual installation instructions for TC-Toolbox for MATLAB®.

I Automatic Installation of TC-Toolbox

When the following conditions are met, Thermo-Calc automatically installs the TC-Toolbox for
MATLAB® component on your computer.

1. MATLAB® is already installed.

2. There is only one Windows user on the computer where TC-Toolbox is being installed.

[% Administrator privileges are needed when you start the Thermo-Calc
installer.

Then follow the regular installation instructions for Thermo-Calc, choosing whether you use a
Standalone or Network installation. If required also see "Testing a TC-Toolbox Installation" on
page 111.

A reminder regarding the license. Although you do not need to have a license file

[% during the installation process (it can be added after the fact), you do need to have
purchased a license for TC-Toolbox for MATLAB® to run the program within
MATLAB®.

I Manual Installation of TC-Toolbox

The installation is not automatic if:

¢ There are multiple Windows users on the same machine, or

¢ The installer cannot find the directory path to the MATLAB installation.

Multiple Windows Users on Same Machine

If there are multiple windows users on the same machine, then the following manual steps are
done at the end of the automatic installation.
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1. A message at the end of the Thermo-Calc installation process displays with instructions.

2. An Explorer window automatically opens to the c:\Users\Public\Documents\Thermo-
Calc\2024a\SDK\TC-Toolbox-MATLAB folder.

3. Double-click the Instal1TCcToolboxMATLAB. cnd file to finalize the process. This briefly

launches MATLAB® and installs TC-Toolbox. If required see "Testing a TC-Toolbox
Installation" on page 111.

Installer Cannot Find the MATLAB® Installation Directory

If the Thermo-Calc installer cannot find the MATLAB® installation directory,
1. Start the version of MATLAB® that you want to install TC-Toolbox in.
2. Open and run the MATLAB® script included with your installation of Thermo-Calc.

For example on Windows, C:\Users\<username>\Documents\Thermo-
Calc\2024a\SDK\TC-Toolbox-MATLAB\setupTCToolbox.m

[% You can also follow the instructions for "Installing TC-Toolbox with the Custom
Option" on the next page.
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Installing TC-Toolbox with the Custom Option

[0 MATLAB® must be installed before you install TC-Toolbox.

As described in "Installing TC-Toolbox" on page 105, if MATLAB® is already installed, then
Thermo-Calc automatically installs the files you need either using the Full Standalone or Full
Network Client installation where you install all features. Otherwise you need to use the
Custom installation.

The following generally describes the Custom option for either a Standalone or Network
installation. Use the Custom option if MATLAB® is installed but the Thermo-Calc installer is not
finding the directory path so you need to enter the path manually.

Some steps are described in more detail in other parts of this guide.

I Step 1. Request your License File from Thermo-Calc Software

A reminder regarding the license. Although you do not need to have a license file

[% during the installation process (it can be added after the fact), you do need to have
purchased a license for TC-Toolbox for MATLAB® to run the program within
MATLAB®.

I Step 2. Download your Thermo-Calc Installation Software
| step 3. Install MATLAB®
I Step 4. Run the Thermo-Calc Installation File as an Administrator

1. Locate the Thermo-Calc installation file on your computer. Right-click the .exe file and
choose Run as administrator to launch the Setup program.

2. Accept the License Agreement and click Next.
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I Step 5. Select the Custom Installation Type

1. Inthe Select Installation Mode window click Custom (the option appears greyed out,
but it is available to select). Click Next.

Full Metwork Client
Install all features
O

Enter the name or IP number of the licensing server

Custom

Choose which features to install

2. On the Specify Configuration window the Create Shortcut on Desktop checkbox is
selected by default. Click Next.

3. Inthe Select Components window, click to select the TC-Toolbox for
MATLAB checkbox.

A Setup

Select Components

Select the components you want to inst:
continue,

Thermo-Calc

Databases

Additive Manufacturing
TC-Python

[] TC-Toolbox for MATLAR (F)
TC-API

TQ-Interface

Remember, you must have MATLAB® already installed and may need to
% know the file path to the MATLAB® folder. If the TC-Toolbox for MATLAB
" checkbox is NOT selected, this confirms that the Thermo-Calc installer did
NOT locate the MATLAB® installation (or it is not installed yet).
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4. Click Next.

5. If you selected the TC-Toolbox for MATLAB checkbox, the MATLAB directory window
opens.

MATLAB (R) directory

MATLAB (R) must be installed before the installation of TC-Toolbox for MATLAB (R).

Enter the MATLAB (R) installation directory | ‘ e
(e.g. C:\Program Files\MATLAB\R2020b)

e |f MATLAB® is already installed but the Thermo-Calc installer could not find the
path, then enter the file path to the MATLAB® installation directory or click the
file button ¥ to Browse for Folder and navigate to the directory. Click Next.

e |f MATLAB® is NOT installed, click Cancel to exit the Thermo-Calc installer
program. Once MATLAB® is installed you can return to this process.

Step 6. Set the Thermo-Calc Installation Directory and Choose the
Setup Type

1. Inthe Installation Directory window, either accept the default path or enter a path to
where you want to install the Thermo-Calc software. Click the file button ¥ to Browse
for Folder and navigate to another directory.

Installation Directory

Please specify the directory where Therme-Calc will be installed.

Installation Directory C:\Pmlam Files' Thermo- Calc =l el | 2]

2. Inthe Choose Setup Type window, click Standalone or Network Client.

Choose Setup Type

Select one of the following setup types.
See installation guide for detailed description of the choices.

Standalone

Choose a license file C:\Users\amanda\DownI0ads\|servrc| | e

Network Client

Enter name or IP number of the licensing server
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» For a Standalone installation: In the Choose a license file field enter the path to
your license file (called Iservrc).

e For a Network installation: Enter the details as required into the Enter the name
or IP number of the licensing server field. Click Next.

r

If the TC-Python checkbox is also selected to be installed (which it is
_,@,_ by default), the Install TC-Python window is a reminder that
A additional installation procedures are required after Thermo-Calc is
installed.

Step 7. Install and Start Using Thermo-Calc as an Add-on in
MATLAB®

1. Inthe Ready to Install window click Next.

If MATLAB® is not installed (and you selected the TC-Toolbox checkbox) a
message displays to confirm that TC-Toolbox will not be installed until you

[% complete the MATLAB® installation. If MATLAB is installed, click Back to
confirm that the installation path is correct, otherwise Cancel this Thermo-
Calc installation, install MATLAB and start again.

2. Click Finish.
I Step 8. Test the Installation

{:) "Testing a TC-Toolbox Installation" on the next page
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Testing a TC-Toolbox Installation

Generally you can check the installation by first looking in the Home tab to see if the program is
in the menu. Then proceed to running the diagnostic script or another example.

To check the installation, in MATLAB®:

1. From the Add-Ons menu, select Manage Add-Ons.

If TC-Toolbox is in the list it is likely it installed correctly but it is recommended you run
the diagnostic script or another example to confirm.

2. Run the diagnostics script from the folder c:\Users\<user>\Documents\Thermo-
Calc\2024a\SDK\TC-Toolbox-MATLAB\Examples\Miscellaneous Or open and run any
other example to test.

':@:' The TC-Toolbox diagnostic script is also available from our website.
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TC-Toolbox Installation Troubleshooting

Below are some suggestions to help troubleshoot a TC-Toolbox for MATLAB® installation.
I Diagnostic Script

A diagnostic script is available to help you if you have problems running TC-Toolbox.

E] It is important to run this script EXACTLY the same way as you run your MATLAB®
script.

The script automatically prints useful suggestions that, in many cases, will help you to fix the
problem yourself. If you are unable to solve the problem, contact us for support.

The script is based on the version of Thermo-Calc installed and named tc-toolbox-
diagnostic-script-2024a.m. You can find the script in these locations:

e Asan example (diagnostics.m) located in this folder
C:\Users\<user>\Documents\Thermo-Calc\2024a\SDK\TC-Toolbox—-

MATLAB\Examples\Miscellaneous

¢ In the Troubleshooting section of the TC-Toolbox for MATLAB® API Reference
Documentation. Also refer to the Best Practices in the same guide to see if there are any
other solutions or tips.

¢ On our website.
| MATLAB® Installation Directory Not Found

For Windows installations of the TC-Toolbox for MATLAB® component, you may get an error
message or window asking for the MATLAB® installation directory path.

r

The most common reason for this is that MATLAB® is not installed. If this is the
:@: case, exit the Thermo-Calc installation, install MATLAB® and then run the
Thermo-Calc installation program again.

If MATLAB® is installed and Thermo-Calc just did not find the file path during the installation
setup process, then enter the path in the field when prompted.
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I Determining the Licensing Software Version (Network Installs)

Sometimes you may need to know the version of License Manager (Windows) or License Server
(Linux) software being used. This can be useful while troubleshooting network installations.

On Windows open a command prompt and go to the directory where 1servnt.exe is
found. For example:

>C:\Program Files (x86)\Common Files\SafeNet Sentinel\Sentinel RMS
License Manager\WinNT

Type the command >1servnt.exe -help and the version is displayed.

On Linux open a Terminal window and go to the directory where the 1serv script is
saved. For example:

>cd opt/Thermo-Calc/<version>/Licensing-files

Type the command >./1serv -help and the version is displayed.
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Uninstalling TC-Toolbox for MATLAB®

Uninstallation requires that the user is logged in with administrator rights and Thermo-Calc is
installed for this same user. Then the uninstallation is automatically completed as part of the
uninstallation of Thermo-Calc. Otherwise a manual step is required.

To uninstall TC-Toolbox (when not automatically uninstalled):

1. Start MATLAB®.
2. Inthe Home tab from the Add-Ons menu, select Manage Add-Ons.
3. Right-click TC-Toolbox and choose Uninstall.
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Troubleshooting
There are diagnostic scripts available for TC-Python and TC-Toolbox for MATLAB®
(these are included as examples in the Miscellaneous folder). These scripts are also
available on our website.
In this section:
LiCeNSE ErrO S 116
Determining the Current License File Directory Path ..., 118
Specifying a New Server Name or IP Number ... 120
FireWalls . 121
Client/Server MismatCh ... 122
macOS Installations: Running the License Initialization Script ........................................ 124
Linux Installations: Running the License Initialization Script ... 125
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License Errors

Troubleshooting

Issue Platform

How do | add or update a

standalone (SUNLL) license

on a Windows computer Windows
where Thermo-Calc is

already installed?

How do | add or update a

standalone (SUNLL) license

on a Linux computer where Linux
Thermo-Calc is already

installed?

How do | add or update a
network license on Windows
Windows?

How do | add or update a

. . Linux
network license on Linux?

No license file found. Copy a
valid license file to the
installation directory after
completing the installation.

All

TC-Toolbox for MATLAB® Windows

Warning Environment
variable “LSHOST” is not set.
Software will not function

properly.

All

Problem running post-install
step. Installation may not

complete correctly.
Linux and
Unable to run post- Mac

installation script, run the
license initialization script as
root after the installation.

Installation
type

Standalone

Standalone

Network

Network

All

All

Network

Standalone

Action or link to more information

"Determining the Current License File Directory
Path" on page 118

"Determining the Current License File Directory
Path" on page 118

"Determining the Current License File Directory
Path" on page 118

"Determining the Current License File Directory
Path" on page 118

You get this message if the wrong path or no
license file is found at a path entered during the
installation process. See "Installation Default
Directories and the License File " on page 21 and
"Determining the Current License File Directory
Path" on page 118

"TC-Toolbox Installation Troubleshooting" on
page 112

"Specifying a New Server Name or IP Number"
on page 120

"macOS Installations: Running the License
Initialization Script " on page 124or "Linux
Installations: Running the License Initialization
Script" on page 125
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Installation
type

Troubleshooting

Action or link to more information

Firewall warnings related to
license management
software (License Manager
and License Server)

Client / Server naming
mismatches

InstallScript engine missing

Windows and
Linux

Windows and
Linux

Windows

Network

Network

Network

"Firewalls" on page 121

"Client/Server Mismatch" on page 122

You are not notified if the InstallScript scripting
engine is not installed. Install the ISScript.msi file
and then run the downloaded file from
Thermo-Calc again as described in "Windows:
About Installing the License Manager" on

page 47
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Determining the Current License File Directory Path

This topic explains how to find out where your license file is installed, either by default or if a
different directory was chosen for previously installed versions. For new installations, where
you may not have had a license file when you installed Thermo-Calc, you can also use these
instructions to determine the correct file path.

From Thermo-Calc

If you have already installed Thermo-Calc, you can view the path to the license file in the GUI.
Select Help - Show License Info.

In Console Mode you can run the SYS module command DISPLAY_LICENSE_INFO.

Windows Standalone Installations

How do I add or update a standalone (SUNLL) license on a Windows computer where
Thermo-Calc is already installed?

1. Unpack the .zip file that contains your standalone license and save the LSERVRC file on
your computer. Find out where to place the new license file by opening a Command
Prompt Window (cmd.exe) and type in the command line:

>set LSERVRC

2. Press Enter. The output from the command is the path to the license file (including the
name of the license file). For example: if the output is

LSERVRC=C:\Users\<user>\Documents\Thermo-Calc\lservrc

then the new license file should be placed in c:\Program
Files\Thermo-Calc\2024a\

Linux Standalone Installations

How do I add or update a standalone (SUNLL) license on a Linux computer where Thermo-Calc is
already installed?

Find out where to place the new license file by opening a Terminal window and type in the
command line:

echo S$LSERVRC

Windows Network Installations
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How do I add or update a network license on Windows?

Only the WIAdmin tool can be used to update the network license used by the License
Manager. See Install the Thermo-Calc Network License Using WIAdmin.
Linux Network Installations

How do I add or update a network license on Linux?

Replace your current license file with the new license file. The license file is located in the same
directory as the license server.
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Specifying a New Server Name or IP Number

The Thermo-Calc Setup wizard does not warn you if the name or IP number entered to the
server (with the license management software) is incorrect.

If the name or IP number is not set at all, or if it is set to an empty string, then when you start
Thermo-Calc the following message displays: Warning Environment variable “LSHOST” is not
set. Software will not function properly.

Windows

This section explains how to specify or change the name or IP number of the server where the
License Manager is installed and for a consolidated network client installation.

To install a license for an existing Thermo-Calc program, follow these steps:
1. Close all running Thermo-Calc programs.

2. Open a command line window.

3. Specify the name or IP number of the licensing software server. Type:

set LSHOST=<name/IP number>

To display the current name or IP number, type:

set LSHOST

macOS

Permanently set the environmental variable LSHOST to specify a new licensing server name or
IP number. Refer to the file /applications/Thermo-Calc-2024a.app/Contents/Info.plist

In this file, you can manually set the TC24A_HOME variable, which specifies the home directory
of the Thermo-Calc program. See the info.plist file for an example.

Linux

You can set or change the name or IP number of the license server at a later time by setting the
environmental variable “LSHOST” to this name or number.
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Firewalls

Windows

For a Windows License Manager installation you may have to change the system firewall
settings to allow the License Manager to communicate with the computers running the client
applications. Go to the Windows Firewall settings window to see if there are any problems. If
prompted, select Unblock the system firewall for the Sentinel RMS License Manager and click
Next.

Linux

For a Linux License Server installation you need to open the UDP port 5093 in your firewall. In
case you have installed SELinux you might also need to disable it by setting SELINUX=permissive
in the /etc/selinux/config file.
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Client/Server Mismatch

For some network installations there can be a naming mismatch that causes errors. The server
(where the license management software is installed) gets information from its DNS servers
that an IP address (aaa.bbb.ccc) belongs to a computer (Computer A). But the client computer
identifies itself as having a different IP address (aaa.bbb.ccc.eee) for the same computer
(Computer A).

Even if the IP address of the client computer belongs to a subnet range listed in the license file,
there is a problem with accessing the license file because the computer name does not match
the information.

You may need your organisation’s network administrator to assist with this issue.

How to Check
Compare computer names on the client computer and server

1. On the client computer, start a command prompt cmd.exe and type ipconfig /all.
Press Enter. A variety of data is displayed on screen. Write down the following
information for later comparison:

¢ Hostname
e DNS Suffix
e Current IPv 4 Address

2. Inthe command window, type nslookup <client_computer_name>, where client_
computer_name is the actual name of the client. Press Enter.

This shows what information is saved on the DNS Servers used by the client
computer. This information should match what is shown in the output from the
first step.

3. Onthe server that holds the license management software, open a command prompt
and run the command line: nslookup client computer name. The output lists the
information for this server.

Does it match the information given by the command ipconfig /all on the client
computer? If not try the following.
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Try these options to correct the issue

1.

If the client computer has a dynamic (DHCP) IP address, either change it to a static one
or make a reservation on the DHCP Server so that the computer always get the same IP
address.

Update the records on the DNS Servers used by both the client computer and the server
computer.

You can also configure the computer names and IP addresses in the local Hostfile of the client

and server:

1. On the client computer, make a backup copy of the file
C:\Windows\System32\drivers\etc\hosts.

2. Open the original in a simple text editor.

3. Add a new line which contains the IP and name of the server, for example:
192.168.29.27 license_server.thermocalc.se.

4. Save the changes.

5. On the server, make a backup copy of the file /etc/hosts.

6. Open the original in a simple text editor.

7. Add a new line which contains the IP and name of the client, for example: 192.168.29.47
Computer_A.thermocalc.se.

8. Save the changes.

9. Inthe host file, there is an example of how the operating system (Windows or Linux)

wants the line in the hosts file to look like.
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macOS Installations: Running the License Initialization
Script

As part of the Standalone installation of Thermo-Calc, the Setup runs a license initialization
script. If this part of the installation process did not complete properly for a standalone
installation, you must manually run the license initialization script. You need the administrator
username and password for these steps.

How to Run the Script

For this script to successfully initialize the license, the license file must be called Iservrc and be
located in the folder:

/Users/Shared/Thermo-Calc

F =

s

1.

"Installation Default Directory: macOS" on page 23

Open a terminal window. The Terminal application is in the /Applications/Utilities
folder.

At the prompt, enter this command:

$ sudo /Applications/Thermo-Calc-
2024a.app/Contents/Resources/license-initialization-macOS-x86
64.sh

If you are not already logged in as an administrator, you probably cannot run the sudo
command. If this is the case, then you can use the su command in the terminal window
to login as an administrator. Contact your local system administrator for help.

Enter the administrator password and press Enter.

When you restart your computer and run the license initialization script, you are ready
to start using Thermo-Calc.

[% If you did not install a license file during this procedure, you can still start
Thermo-Calc although you will get the No license file found message.
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Linux Installations: Running the License Initialization
Script

As part of a Standalone installation of Thermo-Calc, the Setup runs a license initialization script.
If you get a warning message during the standalone installation Unable to run post-installation
script, run the license initialization script as root after the installation, then you need to
manually run the script as root.

openSUSE Administration (sudo) Users

Note the following if you are a sudo user (administrator) in openSUSE installing Thermo-Calc
using this command:

sudo ./Thermo-Calc-linux-<full-version-number>.run

When this command is used, you will do a text-based installation instead of having a graphical
interface to guide you. The information is the same, just without the user interface.

a )

For example, the <full-version-number> is not just 202443, it is what is found in the
:@: Help - About window in Thermo-Calc and it changes every release. You can find
the current full version number listed on our website.

How to Run the Script

[% For this script to successfully initialize the license, the license file must be called
Iservrc and be located in the directory where you have installed Thermo-Calc.

() "Installation Default Directory: Linux" on page 24

1. Inthe console, go to the Thermo-Calc installation directory.

e The license file is put in /home/<user>/Thermo-Calc if you are installing as a
non-root user, where <user> is your user name.

e If you are installing as root, then this directory is opt/Thermo-calc/.
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2. Enter this command:

$ sudo sh license-initialization-linux.sh

If you are not able to execute the sudo command because you are not on the sudoers
list, you must log in as a root user with the command su, and then use sh to run the
license initialization script. For example, on a 64-bit computer, enter the following:

S sh license-initialization-linux.sh

3. Log out of Thermo-Calc and then log back in to save these changes.
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Sentinel RMS License 9.7 Tools

These tools relate to Network Client installations of the Sentinel RMS License software.

@ "Windows: Installing the Sentinel RMS License Manager" on page 49 or "Linux:
Installing the Sentinel RMS License Server" on page 55

In this section:

GetHostID: Get HostID/Mac Address ... 128
Ismon: Monitor License Manager Transactions ... 129
Ispool: Maintain Redundant License Manager Pool ... 130
Isrvdown: Shut Down the License Manager ... ... 132
Iswhere: Display a List of License Managers ... 133
WImAdmin Administrative Tool ...l 134
Sldemo: Show Basic APl FUNCtions ... 138
Wechoid: Get a Computer Locking Code ... 142
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GetHostID: Get HostID/Mac Address

GetHostID is a tool that retrieves the HostID/Mac address from the computer hosting the
license server and saves it to a text file.

S

For Linux the output file is called gethostid.log. For Windows it is called Tc
Hostid. txt.

This is related to the "Full Network Client Installations" on page 45 using the Sentinel
RMS License Manager (Windows) or Server (Linux), version 9.7.

The tool is applicable to Windows and Linux (32-bit and 64-bit) operating systems. See
"Windows: Installing the Sentinel RMS License Manager" on page 49 or "Linux: Installing
the Sentinel RMS License Server" on page 55.

I Windows

Extract getHostID win.zip.

Right-click getHostID win.bat and select Run as Administrator from the menu.

The output is saved in a file: Tc_Hostid.txt located in the same folder as getHostID

win.bat.

| Linux 32-bit

1.
2.

Extract gethostid. tar.

Run the command: >. /gethostid.

The output is saved in a file: gethostid.log located in the same directory as gethostid.

I Linux 64-bit

1.
2.

Extract gethostid64.tar.

Run the command: >. /gethostidé4.

The output is saved in a file: gethostid.log located in the same directory as
gethostido64.

GetHostID: Get HostID/Mac Address | 128 of 152



Sentinel RMS License 9.7 Tools

Ismon: Monitor License Manager Transactions

e This is related to the "Full Network Client Installations" on page 45 using the Sentinel
RMS License Manager (Windows) or Server (Linux), version 9.7.

¢ The tool is applicable to Windows and Linux (32-bit and 64-bit) operating systems. See
"Windows: Installing the Sentinel RMS License Manager" on page 49 or "Linux: Installing
the Sentinel RMS License Server" on page 55.

Platforms
Windows, Linux 32-bit, Linux 64-bit

The tool retrieves information about all features currently licensed by the Sentinel RMS License
Manager, licenses, and clients.

On UNIX computers, you can use "Poll-interval-in-seconds" to specify that Ismon should keep
monitoring and reporting usage activity instead of displaying information once and stopping. If
specified, Ismon waits for that many seconds between re-polls of the License Manager.

Ismon monitors all licensed applications supported by a License Manager. If the License
Manager supports licensed applications from multiple vendors, then all licenses for all vendors
are displayed.

e On Windows, use 1smon [Server-host]

e On Linux 32-bit, use 1smon [Poll-interval_in_seconds] [Server-host]

¢ On Linux 64-bit, use 1smon64 [Poll-interval_in_seconds] [Server-host]
Options

e Poll-interval_in_seconds: Enable periodic update at indicated rate. This option is
supported on UNIX only).

e Server-host: The name of the computer on which the License Manager is running. If
Server-host is omitted, Ismon will attempt to talk to the Sentinel RMS License Manager
on the computer indicated in the LSHOST environment variable or in the LSHOST (or
Ishost) file. If the variable or the file does not exist, then it will attempt to contact a
License Manager using the broadcast mechanism. If Ismon fails to find a Sentinel RMS
License Manager, it will display an error message and exit.
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Ispool: Maintain Redundant License Manager Pool

This is related to the "Full Network Client Installations" on page 45 using the Sentinel
RMS License Manager (Windows) or Server (Linux), version 9.7.

The tool is applicable to Windows and Linux (32-bit and 64-bit) operating systems. See
"Windows: Installing the Sentinel RMS License Manager" on page 49 or "Linux: Installing
the Sentinel RMS License Server" on page 55.

Ispool is a redundant License Manager administration utility (command-line) for Windows and

UNIX.

Options

n Displays a list of Ispool usage options.

a <license manager> Adds the License Manager to the redundant License Manager pool.
Specify the hostname or IP address of the License Manager system. Modifies the
redundant license file.. On Windows, dynamic addition of License Manager in an existing
redundant pool is not supported.

d <license manager> Deletes the License Manager from the redundant License Manager
pool. Specify the hostname or IP address of the License Manager system. Modifies the
redundant license file. On Windows, dynamic deletion of License Manager in an existing
redundant pool is not supported.

1 Displays the host name of the leader redundant License Manager.
p Displays the list of License Managers in the redundant License Manager pool.

g < feature> <version> Displays the license token distribution criteria for the specified
feature/version. If the version is not specified, it must be replaced with empty quotation
marks: " ".

L <event> <OFF | ON> Disables/enables logging for an event. The events you select will
be logged into the License Manager trace log file (only if error logging is enabled).

Ispool - L Options

Events that can be logged using the -L option are given below. The following events are
temporarily logged (except 1) and need to be set each time the License Manager is restarted.

0 Logs all events.

1 Logs when the License Manager is up. On by default. 2 Logs election of the leader
License Manager.
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3 Logs the two-way redundant License Manager heartbeat:> Leader License Manager
periodically logs the update status received from all its followers

> Follower License Manager periodically logs the update about the contact established
with the current leader License Manager

5 Logs the usage information event, shared by the leader, regarding the number of
tokens issued. 7 Logs the license token distribution information synchronization event.

9 Logs when the License Manager is down.

11 Logs addition of a license into the file or memory. Also logs deletion of a license from
the memory.
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Isrvdown: Shut Down the License Manager

e This is related to the "Full Network Client Installations" on page 45 using the Sentinel
RMS License Manager (Windows) or Server (Linux), version 9.7.

¢ The tool is applicable to Windows and Linux (32-bit and 64-bit) operating systems. See
"Windows: Installing the Sentinel RMS License Manager" on page 49 or "Linux: Installing
the Sentinel RMS License Server" on page 55.

Isrvdown utility is used to shut down the named License Manager.

Platforms

Windows, Linux 32-bit, Linux 64-bit

¢ On Windows and Linux 32-bit use 1srvdown host-name

¢ On Linux 64-bit use 1srvdown64 host-name

Isrvdown can be run from the operating system command prompt by an administrative user on
a client or License Manager computer.

e On UNIX, only the user logged in as “root” can use Isrvdown.

¢ On Windows, any user with administrative privileges may use Isrvdown unless the
License Manager was started by a user logged in as Administrator, in which case only
Administrator can shut the License Manager down. The computer on which you are
running Isrvdown must be in the same network domain as the License Manager
computer.

[% The same user must install the Sentinel RMS License Manager and also run
this utility.
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Iswhere: Display a List of License Managers

e This is related to the "Full Network Client Installations" on page 45 using the Sentinel
RMS License Manager (Windows) or Server (Linux), version 9.7.

¢ The tool is applicable to Windows and Linux (32-bit and 64-bit) operating systems. See
"Windows: Installing the Sentinel RMS License Manager" on page 49 or "Linux: Installing
the Sentinel RMS License Server" on page 55.

Platforms
Windows, Linux 32-bit, Linux 64-bit

Iswhere command displays the network names of the computers running the License Manager.
By default, Iswhere displays for each License Manager the address of the computer on which
that License Manager is running as well as its host name.

Iswhere can be run on Windows and UNIX. Iswhere should be run from the operating system
command prompt by an administrator or application user on a standalone, client, or License
Manager computer.

Iswhere should be run in the following format:

¢ Windows and Linux 32-bit: 1swhere [option]

e Linux 64-bit: 1swhere64 [option]
Options

¢ d Displays details on the License Managers found on the network.

e r Displays only the IP addresses of the License Managers found on the network (resolves
the host names). Iswhere can also be run without specifying any command line options.
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WImAdmin Administrative Tool

This is related to the "Full Network Client Installations" on page 45 using the Sentinel
RMS License Manager for Windows, version 9.7.

The tool is applicable to Windows operating systems. See "Windows: Installing the
Sentinel RMS License Manager" on page 49.

WImAdmin performs a variety of administrative functions for the license management
activities. It displays elaborate information that includes the License Manager information,
feature information, and license and client information.

Platform

Windows

S

WImAdmin can administer a remote Linux license server.

I WIimAdmin Functions

Provides information on the License Managers.

Details on licenses and clients using them in the network. For example, the
administrator can see which users have acquired that license and who are in a queue
waiting for the license.

If you are using redundant License Managers, you can use WImAdmin as an informational tool

to:

Add or delete a redundant License Manager from the redundant License Manager file.

Display a list of all License Managers in the redundant License Manager pool and display
the name of the License Manager leader.

Display the distribution criteria for specific licenses (only high assurance model is
allowed, where the reigning leader server keeps all the license tokens).
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View License Manager Information

Click the name of a License Manager in the left-hand pane of the main window. In the
right-hand pane of the display, you see the IP address of the computer containing the
License Manager and its host name.

Add or Remove a License Manager from the Defined Server List

To add a License Manager: Right-click the name of a License Manager in the list of
Subnet Servers. From the menu select Add to Defined List.

To remove a License Manager: Right-click the name of a License Manager in the list of
Defined Servers. From the menu select Remove from Defined List.

Add a License Code to the License Manager from a File

Right-click the name of a License Manager in the left-hand pane of the main window.
From the menu select Add Feature > From a File > To Server and its File.

To add the license from a file, select From a File. This permanently adds the license code
to the License Manager license file as well as to the License Manager memory.

In the new windows, browse to the source file that contains the license code and click
Open.

Select the license code file.

Delete Old License Features from the License Manager

1.

o vk~ W N

Right-click the file wimadmin.exe and select Run as Administrator.

If the license server is not found under subnet servers, go to Edit > Defined Server List.

Enter the host name or IP address of the license server.

Click Add and OK.

Click View > Refresh All to update the list.

Right-click the name of a License Manager in the left-hand pane of the main window.

From the menu select Remove all Features
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Shut Down a License Manager

¢ Right-click the name of a License Manager in the left-hand pane of the main window.
From the menu select Shutdown Server.

I Setting WimAdmin Preferences
WImAdmin allows you to choose what to display when it starts.

From the Edit menu, select the Preferences command to view WImAdmin Preferences:

Preferences >

Timeout interval:  {EIL
Broadcast interval: |5 Cancel |

Server Port: 5033

| Discover subnet servers on startup
[ Discover defined servers on startup
| Hide client librany emor handler messages

[ Savethese preferences to a file

¢ Timeout Interval: The number of seconds after which WImAdmin will stop trying to
contact a License Manager. If you have a large network or a slow one, you might want
to increase this number if you find WImAdmin has difficulty retrieving information from
License Managers.

¢ Broadcast Interval: Specify the number of seconds between broadcasts to the network
to discover License Managers.

e Server Port: To set any custom port (other than the default port 5093) on which the
RMS License Manager is running.

[% Set this port number before you add that License Manager in the list of
defined servers.

¢ Discover subnet servers on startup: To automatically discover and display the License
Managers on your subnet.
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Discover defined servers on startup: To always show the License Managers you have
defined.

Show client library error handler messages: To pass license management error
messages from Sentinel RMS to WImAdmin.

Save these preferences to a file: To save your choices.
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Sldemo: Show Basic API Functions

e This is related to the "Full Network Client Installations" on page 45 using the Sentinel
RMS License Manager for Windows, version 9.7.

¢ The tool is applicable to Windows operating systems. See "Windows: Installing the
Sentinel RMS License Manager" on page 49.

simdemo is a Windows-based graphical sample program to show basic API functions. Evaluate it
using the steps described here to understand the basic API calls and test the connectivity
between client and license server

[% simdemo can be used to test the connectivity to a remote Linux license server

Platform
Windows

Right-click on the executable and select Run as administrator. simdemo calls the VLSinitialize
APl when the application is invoked successfully.
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m Sentinel RMS Development Kit Demno — >

File ConnectTo

Connected Server : NOMNE

Feature; YWersion:

|99

Team Capacity |1zer Capacity

Get License |

Avalable: 0 InUsze: 0 Tatal: 0

Heleaze Licenze

AP Call Hiztory

[rvoked YL Sinitialize(). 4 The call retumed a success status af Ox0.

Set the contact server (License Manager) under the Connect To > Server menu option. Enter a
hostname , Which is the hostname or IP address of the License Server.
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H Sentinel RMS Development Kit Demno —

File ConnectTo

Connected Semvel gener Workstation

Feature;

Server Mame: ]<hDStﬂamE>

Cancel

|99

Team Capacity

| 1
Get License Heleaze Licensze

Avalable: 0 InUsze: 0 Tatal: 0

AP Call Hiztory

[rvoked YL Sinitialize(). > The call retumed a success status af Ox0.

Sentinel RMS License 9.7 Tools

Click OK and enter in the field one of the license features available in the network license file.
Where Feature is the name of the feature ex. TC_FULL and Version is the license version in the
NWL (Network) license. Click Get License. The message The call returned a success
status of 0x0 means that the connection client <> license server works.
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m Sentinel RMS Development Kit Demo —

File ConnectTo

Connected Server : licmgmt. ad.thermocalc. se

Feature: Werzion:

ITE_FLILL

21.000

r EH

Team Capacity

Bt

I1zer Capacity

InUsze: 4 2097150

Tatal:

Avalable: 2097146

AP Call History

» Server name [192.168.29.42] zet for connection!

Inwoked VYLS setContactServer(].> Server name [thoth, ad. thermocale,
ze] zet far connectionllnvaked VLS setCantactServer).

» Server name [licmagmt. ad. thermocals. 2e] zet for connection
Irwoked VLS setContactServer().> Server name [licmgmt. ad.
thermocals. ze] et for connection!lmwvoked VLS _REQUESTI]L

» The call returned a success statuz of Os0 lnvoked VLS _RELEASE]]
Al he call returned a success status ot U

~

W

To save the log, click File > Save log.

Sentinel RMS License 9.7 Tools
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Wechoid: Get a Computer Locking Code

e This is related to the "Full Network Client Installations" on page 45 using the Sentinel
RMS License Manager for Windows, version 9.7.

¢ The tool is applicable to Windows operating systems. See "Windows: Installing the
Sentinel RMS License Manager" on page 49.

Before your software vendor creates a license code with any computer restrictions, you must
get the locking code for your computer with the Wechoid program. Your software vendor will
tell you which computers you must run Wechoid on. The Wechoid utility outputs either one or
two hexadecimal locking codes depending upon how your software vendor has configured it.
You will send all locking information to your software vendor. Your software vendor will use
this information, which is specific to your computers, to generate new license codes.

Platform
Windows

When launched, the utility shows the available lock criteria (a checkmark is added next to each)
and the values. Click to clear (uncheck) all checkboxes except for Ethernet Address.
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Fl Wechoid
~Lacking Criteria

[~ IPAddress | 192.168.29.42
[~ IDPROM |
[T DiskID | 0xSBDBSSEA
[T HostName I LICMGMT
[V EthemetAddress | 6C-2B-59-8A-3D-FA
[T ComputerID I
™ 3ard Disk Serial | 39SEK82QF9NF
[~ Standard Custom I
[~ CPU Info String | Genuinelntel Intel(®) Xeon(R) E-2124 CPU |
I uvum | 4C4C4544-004B-3710-8043-BOCOSF 575732
[ Estended Custom I
Locking Data

o New Style " Old Style

Selector [0:10  Code |*INX9QVS VMFU 7GDZ

oK

Wechoid: Get a Computer Locking Code | 143 of 152



Updating or Uninstalling the Software

Updating or Uninstalling the Software

@ Also see "Uninstalling TC-Toolbox for MATLAB®" on page 114

In this section:

Updating the Software for Interim Releases ... 145

Uninstalling Thermo-Calc ... 151
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Updating the Software for Interim Releases

The full version of Thermo-Calc software is released twice a year. The software releases are
named after the year of the release followed by an “a” for the first release of the year or a “b”
for the second release of the year. For example, this release is 2024a.

Occasionally after a full release, an interim release version, an update, is required to fix a
serious bug or to address an external issue that occurred after the full release. Software
licenses come with a free 12 month Maintenance & Support Subscription, starting from the
time of purchase, and this includes these software updates.

Go to our website to confirm the current distributed software version and
ﬁ determine if there are updates, or to learn more about Maintenance and Support
options.

\.

I Installing an Updated Version of the Software
I Step 1. Check for a Software Update

You can set your software to automatically check for updates upon start up.

e From within the software on the Options window, General tab, set Check update
interval to On start up.

To open the Options window:
e Windows: Select Tools = == Options.

e Mac: Select Thermo-Calc <version> - Preferences or Settings or press <38> on
the keyboard.

e If you do not have Automatic Updates on you can go to Help = G Check for Updates .
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Ay File Tools Windu:uw

M M EH B O onlineHelp F1

[*] Video Tutorials
Project

|~ Example Files...

.. Manuals Folder

Thermo-Calc Website

gj‘i- Show License Info
Py Projed
MY TTOJe Check for Updates .

[1’? Request Support

o About

I Step 2. Follow the Installation Instructions for the Applicable OS

After the software has checked for updates and determined there is one, the applicable
installation file for your operating system is downloaded. Then follow the instructions provided
in the Installation Guide for the specific operating system and license type.

For an update to the software, no additional license files are required.

I Step 3. Option to Save Backup User Created Files

. There are significant operating system differences regarding what backup files are
saved if you are installing an update on Windows versus macOS or Linux.

During the installation process, several default folders are added to your system that include
documentation, materials, and example files. This is the same for all operating systems. During
an update, Thermo-Calc runs a check of these default folders to determine if there are changed
or new user files that are saved in these folders. For example, you might have saved a
completely new project *. tcu file into the Examples folder, or after running one of the included
examples such as T_06_Serial_Equilibrium_Calculators.tcu, the default file is changed and now
includes results.
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On Windows operating systems, Thermo-Calc gives you the opportunity after the installation to
specifically save a backup of these user created or modified files to your Documents folder
when you open Thermo-Calc for the first time after the update.

However, for macOS and Linux operating systems, the behavior is different due to limitations
enabling the identification of changes to some files.

Operating When does backup
(] occur?

What files are copied?

After installation,

Windows when you open the Documents, Materials, and/or Examples files are copied when you choose
software for the first Yes at the prompt (see the Windows section for details).
time
There is an option during the installation process to save a backup copy of
the Examples folder even if no changes are made to files (see the macOS or
macOS Linux sections for details).
During installation Materials and Documents folders are not automatically
copied even if there are file changes or additions.
L However, you can always manually back up these folders
inux (see the macOS or Linux sections for details).
Windows

First complete the installation update. Then when you open Thermo-Calc for the first time, and
if Thermo-Calc identifies that there are changed files, you are prompted with a Software
Update - Action Required window that identifies the folders where the applicable files are
changed or added.

[% These file types are not kept, i.e. these are excluded: dll, exe, lib, miltbx, pdf, whl,
html, and htm.

Click Yes to save a backup of these changed files or No to continue opening Thermo-Calc as
normal where the default set of folders are copied from the source Public Documents location
into a user pocuments folder.
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If you choose to save a backup of the files, the new backup folder is added to this same
location, for example:

C:\Users\<user>\Documents\Thermo-Calc\2024a backup

O "Installation Default Directory: Windows" on page 22

macOS

During the installation process you are prompted with a Software Update - Action Required
window.

[% This window always displays whether there are changes or additions to the folders
or not.

Software Update - Action Required A

All files in the following folders will be replaced:
Examples, Manuals, Materials,
ProcessMetallurgyMaterials, PropertyModels, SDK.

To create a backup copy of the Examples folder, including changed files, select Yes. Or select No to
replace all files.

e Yes

No

Click Cancel to exit the installation process if you
want to manually save a backup of any other folder.

The Materials and Documentation folders do not automatically have a backup
saved. If you think there are user files you want to keep it is recommended that

you click Cancel at this prompt to exit the installer, then manually copy the folders
to another location. Then start the installation update process again.

To create a backup copy of the Examples folder, including changed files (i.e. all files are copied,
not just the changed or new ones). Options at this prompt are to click:
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e Yes to create the backup.
* No to replace all files.

e Cancel to exit the installation process, i.e. to manually save a backup of any other folder.

The default backup folder containing a full copy of all the contents of the Examples folder is
saved to this location, for example:

/Users/Shared/Thermo-Calc/2024a/Examples backup

O "Installation Default Directory: macOS" on page 23

Linux

During the installation process you are prompted with a Software Update - Action Required
window.

[% This window always displays whether there are changes or additions to the folders
or not.

Software Update - Action Required A

All files in the following folders will be replaced:
Examples, Manuals, Materials,
ProcessMetallurgyMaterials, PropertyModels, SDK.

To create a backup copy of the Examples folder, including changed files, select Yes. Or select No to
replace all files.

®) Yes
No

Click Cancel to exit the installation process if you
want to manually save a backup of any other folder.

The Materials and Documentation folders do not automatically have a backup
saved. If you think there are user files you want to keep it is recommended that

you click Cancel at this prompt to exit the installer, then manually copy the folders
to another location. Then start the installation update process again.
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To create a backup copy of the Examples folder, including changed files (i.e. all files are copied,
not just the changed or new ones). Options at this prompt are to click:

¢ Yes to create the backup.
¢ No to replace all files.
¢ Cancel to exit the installation process, i.e. to manually save a backup of any other folder.

The default backup folder containing a full copy of all the contents of the Examp1les folder for

Linux depends if you are a root super user requiring administrative privileges or a common
user.

For example, for a common user:
/home/<user>/Thermo-Calc/2024a/Examples backup

For example, for a root user:

/opt/Thermo-Calc/2024a/Examples backup

P
I A

"Installation Default Directory: Linux" on page 24
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Uninstalling Thermo-Calc

Ii:) "Uninstalling TC-Toolbox for MATLAB®" on page 114

Windows 10

1. From the Control Panel Desktop app, go to Programs - Programs and Features -
Uninstall or change a program.

2. Inthe list of programs, locate the version of Thermo-Calc you want to uninstall. Click to
highlight that row.

3. Click Uninstall/Change.

4. In the Setup window, Uninstallation Mode dialog box, choose to uninstall the Entire
application or Individual components. Follow the instructions to finish.

macOS

Deleting the program from the Applications folder does not remove the program from your
operating system. Run the Thermo-Calc-<version>-uninstaller program located in the
Applications folder.

1. Go to the Applications folder and double click the file that starts with Thermo-Calc-
<version>-uninstaller. Enter the administrator’s user name and password.

2. Click Yes to choose Entire application or select individual components. Otherwise click
No to quit.

3. The Uninstalling Thermo-Calc window shows the progress. Click OK when prompted.

Linux

1. To start the uninstallation procedure, in the Thermo-Calc installation directory use the

command
./Thermo-Calc-2024a-uninstaller.run

For Thin Client installations, use the command

./Thermo-Calc-client-2024a-uninstaller.run
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2. Toremove the whole application, including all its components, select Entire application
and click Forward, or to remove specific components, select Individual components and
click Forward.

If you intend to reinstall Thermo-Calc 2024a it is important to (1) Restart the
E] computer before you reinstall the software and (2) remove the environmental
variable TC24A_HOME.
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